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1.1　背景と目的

　農研機構は、2017年に「ドローンを用いたほ場計測マニュアル（不陸（凹凸）編）」（図 1-1）
を刊行しました。その中の第 3章「地上基準点（GCP）の測量」の応用編として、対空標識
（地上基準点）の座標値をより高精度に取得する方法について説明しています。一般的に普及
するスマートフォンやハンディ GPSでも手軽に位置座標を計測することができますが、その
精度は一般に数メートル程度となっており、センチメートルレベルの空間分解能をほこるド
ローン空撮画像の幾何補正情報として用いるのには十
分ではありませんでした。そこで高精度な測位を実現
するために、GNSS衛星から送られる搬送波を 2台
以上の受信機で同時に観測・解析する干渉測位という
方法に着目しました。干渉測位法は、これまで海洋や
測量分野、工事現場などでは利用されてきましたが、
高価な機材が必要だったため他分野での利用は現実的
ではありませんでした。しかし、近年になり専用のア
ンテナや受信機が安価に入手できるようになり、また、
無償のオープンソースである測位演算プログラムパッ
ケージ「RTKLIB」を用いることにより、干渉測位を
誰でも行うことができるようになってきました。本マ
ニュアルは、ドローン観測データの位置精度の向上を
図ることを目的に、これら安価な小型 GNSS受信機
と無償の「RTKLIB」を使った対空標識の座標値の高
精度測位方法について手順を追ってわかりやすく説明
します。

1.2　本マニュアルの注意点・免責事項

　本マニュアルは、安価な小型 GNSS受信機を用いることで、ドローン空撮データから作成
された圃場マップの位置情報を高精度にするための簡便な方法を紹介することを目的としてい
ます。基線解析に用いる RTKLIBの設定パラメータの設定や解析手順等は、他の技術資料で紹
介されている値等を参考にしていますが、必ずしも同じではありません。パラメータや解析手
順等の詳細は、今後、手法の見直し・改良にともなうマニュアル改訂時に修正されうるもので
す。
　本マニュアルは、国土地理院の定めた「マルチ GNSS測量マニュアル（案）-近代化 GPS、
Galileo等の活用 -」に準じない簡易な方法であるため、公共測量等の業務に使うことはでき

ドローンを用いた
ほ場計測マニュアル
（不陸（凹凸）編）

農業環境変動研究センター

図 1-1　 ドローンを用いたほ場計測
マニュアル（不陸（凹凸）編）

はじめに1
小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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ません。したがって、本マニュアルにおける位置座標推定は、測量業者の行う「測量」とは同
一では無いことを明示するため、「測位」という表現で説明しています。また、GNSS電波受
信を妨害する構造物等の有無や観測時の GNSS衛星の数と配置および電子基準点からの距離
によって、位置推定精度は変わりうるため、本マニュアルは測位結果の絶対的な精度の補償を
行うものではありません。本マニュアルの利用に際してご利用者様と第三者との間のトラブル
については、一切責任を負いかねます。

1.3　作業手順概要

　最初に、対象とする圃場内における GNSS観測のための準備と計画を行います。次に、
対空標識を設置します。ドローン空撮を実施した後、対空標識において GNSS観測を行いま
す 1。最後に、GNSS観測で取得したデータを RTKLIBで解析し対空標識の座標を算出します
（図 1-2）。
　この結果を Agisoft PhotoScanなどの SfMソフトへ反映することによって、高精度な 3次
元データやオルソ画像、地表高データ（DSM）を作成することができます（図 1-3）。次章か
ら詳細な手順について説明します。

図 1-2　GNSS受信機による対空標識（地上基準点）測位の作業手順

1  対空標識兼用 GNSS受信機（巻末付録 A①）を使えば、対空標識の設置と GNSS観測を同時に行うこと
ができます。

① 機材の準備・観測計画（P.8）

② 対空標識の設置（P.13）

③ GNSS観測（P.16）

④ RTKLIBによる基線解析（P.19）

Agisoft PhotoScanによる 3次元データ・オルソ画像・地標高データの作成

対空標識の座標

1. はじめに
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　用語説明

　　●　 不陸計測：地表面の凹凸の計測のこと。
　　●　 測位：衛星測位システム等を用いて位置を測定すること。＊本マニュアルは、ドロー

ンによる 3次元計測の補正を目的とした簡易な計測方法のため、公共測量で測量士
が行う「測量」とは同じではありません。そのため「測位」という言葉を使っています。

　　●　 測地成果 2011：国土地理院の構築した高精度な測量成果。
　　●　 GNSS（Global Navigation Satellite System）：全球測位衛星システムの総称であり、

GPS（米国）、GLONASS（ロシア）、Galileo（EU）、BeiDou（中国）、準天頂衛星
［QZSS］（日本）は、各国の測位衛星システムの呼称です。

　　●　 RTKLIB： GNSS観測データの解析を行うためのオープンソースのライブラリとアプ
リケーション群。

　　●　 干渉測位：GNSS衛星から送られる搬送波を基準局と移動局の 2台以上の受信機で
同時に観測し、その擬似距離と搬送波位相を解析することによって、1cmレベルの
精度で位置を求める方法。ただし、移動局の正確な座標を求めるためには、基準局の
正確な位置座標が必要となる。

　　●　 基準局：正確な座標値がわかっている場所に設置された GNSS受信設備。＊本マニュ
アルでは、国土地理院が全国に整備している電子基準点を基準局として使用します。

　　●　 ローカル基準局：電子基準点の代わりとなる自前で設置した基準局。GNSS受信機

図 1-3　対空標識の座標情報を利用して作成した 3次元データ

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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を複数使う場合に、あらかじめ正確な座標値を測位した地点に設置する GNSS受信
機。

　　●　 移動局：対空標識など座標値を計測したい場所に設置する GNSS受信機。
　　●　 スタティック測位：移動局の受信機を同じ位置に長時間固定して測位する方法。
　　●　 キネマティック測位：移動局の受信機を移動させながら測位する方法。
　　●　 地上基準点：画像データの幾何補正を行うために使用する位置座標（緯度・経度・標

高）が既知の基準点のこと。GCP（Ground Control Points）とも呼ぶ。ドローン空
撮の際に対空標識を設置する地点。

　　●　 対空標識：ドローン空撮において、地上基準点の目印として設置する標識。
　　●　 対空標識兼用 GNSS受信機：農研機構のデザインした GNSS受信機。そのまま対空

標識の代わりとしても利用できる。本体に磁石で固定された GNSSアンテナを外せ
ば、地表面に固定された対空標識の中心を計測することができる。詳しくは、巻末付
録 A①参照。

　　●　 SfM（Structure from Motion）：カメラの視点を変えながら撮影した複数枚の画像か
ら、カメラの位置と 3次元形状を復元する手法。

　　●　 比高計測：地点間の高低差（相対値）の計測。
　　●　 基線解析：GNSS観測地点間（基地局と移動局）の幾何学的な位置関係（長さと方

向）を求める解析。
　　●　 楕円体高：地球を楕円体で近似し、その表面からの垂直高。
　　●　 ジオイド面：地球重力の等ポテンシャル面のうち平均海水面に一致する面。
　　●　 ジオイド高：楕円体面からジオイド面までの垂直高。
　　●　 標高：ジオイド面からの垂直高。楕円体高＝ジオイド高＋標高 という関係式が成り

立つ。日本では東京湾の平均海面が標高 0m。
　　●　 SNR（Signal Nose Ratio）：信号雑音比。S/N比とも呼ぶ。SNRの値が大きければ

伝送における雑音の影響が少ないことを表す。
　　●　 DOP（Dilution of Precision）：精度低下率。GNSS衛星の配置状況を指数化した値。

値が大きくなるほど測位精度が低いことを表す。

1. はじめに
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　この章では、GNSS観測を実施前に行う、観測方法と機材、使用する電子基準点の検討、
および、GNSS観測に適した日時を決定するための衛星配置の確認方法について説明します。

2.1　観測機材

①　小型GNSS 受信装置
　　GPS、みちびき等から発信された電波を受信するために使います。
　機種：
　 　衛星からの搬送波を受信しログデータを出力できる受信機およびアンテナ 2を備えたもの
を用意します。本マニュアルでは、観測実績があり比較的安価に購入できる機材を例に説明
をおこないますが、同様の構成の機材であれば問題ありません。u-blox社製 NEO-M8Tの
GNSS受信チップを搭載した製品を巻末付録 A①～④に紹介します。

　　ここでは、巻末付録 A①の「対空標識兼用 GNSS受信装置」を例に説明します。

　台数：
　　1台以上　＊ 2台以上あれば短時間で効率よく測定することができます。

②　対空標識
　　ドローン空撮において、地上基準点の目印として設置します。
　種類：
　 　撮影高度から中心点を確認できる大きさ・模様であれば種類を問いません。巻末付録 J①
に標準的なサンプルを添付しました。

図 2-1　対空標識兼用 GNSS受信機（左）、別途用意した対空標識を計測している様子（右）

2  アンテナの下には、必ずグランドプレーンを付ける必要があります（巻末付録Ａ⑥、参考文献）。ただし、
「対空標識兼用 GNSS受信装置」は、ケース本体がグランドプレーンの役割をするので用意する必要はあ
りません。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）

機材の準備・観測計画2
小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　枚数：
　　5～ 9枚程度 3

2.2　観測方法の選択

　干渉測位を実施するためには、衛星（GNSS）から送られる搬送波を 2台以上の受信機で同
時に観測する必要があります。そのうち 1台は、あらかじめ正確な座標値が分かっている場
所（基準局）に設置し、もう 1台は、座標値を計測したい場所（移動局）に設置します。本
マニュアルでは、座標値の分かっている基準局として、国土地理院が全国に整備している電子
基準点を使用します。

　GNSS観測の方法は、用意できる受信機の数に応じて、以下に示す 3通りの方法から選択
します。それぞれ、必要となる観測時間と、その後の解析方法が異なるので、自分に合った条
件で観測方法を選択します 4。

【A】GNSS受信機が 1台の場合（移動局のみ【スタティック測位】）
　GNSS受信機が 1台（移動局用のみ）の場合は、座標値を計測したい対空標識を順番に移
動しながら GNSS観測を行います。対空標識 1箇所当たりの観測時間は、最低 1時間（スタ
ティック測位）が目安となります 5。
　基線解析は、電子基準点（基準局）の観測データと各対空標識（移動局）の観測データを用
いて行ない、各対空標識の座標値をスタティック測位により算出します。

図 2-2　電子基準点（基準局）と対空標識兼用 GNSS受信機（移動局）の様子
電子基準点の画像は国土地理院の HPより引用

3  撮影エリアの中心に対空標識を置けない場合は、4～ 8枚程度になります。
4  キネマティック測位よりもスタティック測位のほうが精度が良く、ローカル基準点を用いることでさらに
精度を高めることができます。4種類の解析方法（【A】【B】【C1】【C2】）の中では、【C2】の方法が最良
の方法であると考えられます。

5  観測時間を 30分に短縮しても座標値の計算自体は可能ですが、十分な精度が得られない場合があります。

2. 機材の準備・観測計画
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【B】 GNSS受信機が 2台の場合（ローカル基準局【スタティック測位】→移動局【キネマ
ティック測位】）

　GNSS受信機が 2台ある場合は、GNSS受信機の 1台をローカル基準局（電子基準点の代
わりに使う自前の基準局）として設置し、もう 1台の GNSS受信機（移動局）で対空標識を
順番に移動しながら観測します。ローカル基準局の観測時間は、A）の場合と同様で最低 1時
間を目安とします。移動局の観測時間は、対空標識 1箇所当たり 3～ 5分程度 6で済みます。
だだし、移動局の観測中は、ローカル基準局においても GNSS信号を同時受信しておく必要
があります。
　基線解析は、はじめに電子基準点（基準局）とローカル基準局の観測データを用いて、スタ
ティック測位によりローカル基準局の座標値を確定します。次に、ローカル基準局と各対空標
識（移動局）の観測データを用いて、キネマティック測位により各対空標識の座標値をそれぞ
れ算出します。

図 2-3　GNSS受信機が 1台の場合の観測イメージ

図 2-4　GNSS受信機が 2台の場合の観測イメージ

6  観測条件によっては、3～ 5分の観測時間では Fix解が得られないこともあるので注意が必要です。観測
現場で Fix解が得られているかどうかを確認したい場合は、前日までにローカル基準局の設置場所に目印
を付けた上で【Ａ】の方法で位置情報をあらかじめ取得しておく必要があります。ローカル基準局の位置
情報があらかじめ分かっていれば、現地でノート PCを使って後処理キネマティック処理を行い、Fix解
が得られているかどうかを確認することができます。また、この場合、ローカル基準局用に 1時間の観測
時間を確保する必要もなくなるので、観測現場での滞在時間を短縮することも期待できます。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）

 巻末付録Ａの機材（L1波のみ受信）では、キネマティック測位によるFIX解が全く得られない
ことが多々あります。L1波とL2波を受信できる上位機種の利用を推奨します。
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【C】対空標識兼用 GNSS受信機が地上基準点の数だけある場合（【スタティック測位】）
　対空標識兼用 GNSS受信機（巻末付録 A①）が地上基準点 7の数だけある場合は、ドロー
ンの撮影前にすべての地上基準点に対空標識兼用 GNSS受信機を設置します。観測時間は他
の方法と同様で、最低 1時間は必要となりますが、ドローンでの撮影と同時にすべての地上
基準点の観測が行えるので作業時間全体は短くなります。
　基線解析の方法は、以下の 2通りあります。解析の手間はかかりますが、C2）のほうが、
より高い精度を期待できます。

C1）電子基準点を基準局とする方法（スタティック測位）
　上記 A）の観測機材が 1台の場合と同じ方法で、電子基準点を基準局として、各対空標識兼
用 GNSS受信機の座標値をスタティック測位で算出します。

C2） 対空標識兼用 GNSS受信機（地上基準点）のどれか一つをローカル基準局とする方法
（スタティック測位）

　ローカル基準局の座標値を上記 A）と同様にスタティック測位で算出します。次に、電子基
準点の観測データの代わりにローカル基準局の観測データを用いて、その他の対空標識兼用
GNSS受信機の座標値をスタティック測位で算出します。

図 2-5　対空標識兼用 GNSS受信機が地上基準点の数だけある場合の観測イメージ

7  ここでは「ドローン空撮の際に対空標識を設置すべき場所」という意味になります。

2. 機材の準備・観測計画
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2.3　衛星配置の確認（オプション：より精度を高めたい場合に実施）

　GNSS観測を実施する時間と場所で、天空における衛星の配置は常に変化します。その配置
によっては、測位精度を確保することが難しい場合があるので、事前にそれを確認し、GNSS

観測の実施日を検討します。確認方法の詳細については、巻末付録 Bを参照してください。

図 2-6　対空標識兼用 GNSS受信機を高度約 40mの上空から Phantom4 Proで撮影した画像

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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3.1　設置場所の選定

　ドローン空撮の範囲内で以下の条件の場所を選定し、対空標識を配置します。

　（1） GNSS観測で多くの衛星を受信できるように、周りに遮蔽物がなく開けた場所を選定
します。

　（2）GNSS受信機が傾かないように、平らな場所を選定します。
　（3）空撮範囲の全域になるべく多くの地点を配置します。
　（4）空撮範囲の標高が高い場所と低い場所が含まれるように配置します。
　（5）必要に応じて、精度の検証点用の対空標識を追加で 2～ 3点配置します。
　（6） 比高計測（巻末付録 D参照）を実施する場合は、レベル測量の最大視準距離を考慮し

て配置します。

　対空標識の周りにある背の高い雑草は、対空標識の空撮および GNSS観測の妨げになる可
能性があるので、できるかぎり鎌で切っておくのが良いでしょう。また、観測者自身が遮蔽物
とならないように観測スペースにも気を付けます。対空標識は、最低 3点以上あれば解析可
能ですが、精度を確保するためには、空撮範囲内の全域に、標高が高い場所と低い場所を含め、
なるべく多くの地点を配置します（図 3-1, 図 3-2）。さらに追加で 2～ 3点の対空標識を配
置できると、後から精度の検証も行えます。ただし、対空標識を多く配置すると、GNSS観
測や比高計測にも時間がかかるので、精度と作業時間のバランスを考慮して配置します。その

図 3-1　対空標識を設置する際の注意

3. 対空標識の設置

対空標識の設置3
小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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他、比高計測を実施する場合は、レベル測量（巻末付録 D①参照）の最大視準距離（30～ 80

ｍ程度）を考慮し、対空標識の配置間隔を決める必要があります。

3.2　対空標識の設置

　対空標識は、土木・測量用品を扱う会社から市販されており、図 3-3（左）のように撮影し
た画像から中心位置が判別しやすい模様になっています 8。現地では、ドローンで撮影を行う
前に対空標識を設置します。可能であればペグなどでしっかりと固定します。対空標識の設置
場所を識別管理するために、ID番号を振った上で設置場所の状況を野帳にメモをとります 9。
各受信機の観測終了予定時刻（1時間後）を把握することで、撤収時の機材回収をスムーズに
実施することができます。「対空標識兼用 GNSS受信機」を用いる場合は、水準器を使うなど

図 3-2　対空標識の配置イメージ

図 3-3　対空標識（左）、対空標識兼用 GNSS受信機（右）

8  ポスターサイズの印刷ができる大型プロッターを使える方は、巻末付録 Jに簡易対空標識用の原稿を印刷
してご利用ください。折りたたむことのできるポスタークロス（不織布）で作成すると持ち運びに便利です。

9  「対空標識兼用 GNSS受信機（巻末付録 A①）」を使用する場合は、設置時に受信機の電源を入れ正常に
作動していることを確認するとともに、電源を入れた時刻を野帳にメモします。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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して水平 10に設置します。また、標識の大きさ・模様を変更したい場合は、巻末付録 A⑤の
「GNSSアンテナ収納可能な対空標識固定専用マット」を水平に設置した上で使います。ま
た、【B】【C】の GNSS受信機を 2台以上使う場合は、この時点でローカル基準局 11を設置
しておきます（4章参考）。

図 3-4　対空標識および GNSSアンテナ固定専用マット

10  アンテナの傾きは、位置推定精度を悪くする原因となります。手間をかけてでも、厳密な水平を取りたい
場合は、三脚や一脚を使った設置方法（巻末付録 C）を検討してください。

11  次回も同じ場所でドローン空撮を行う場合は、ローカル基準局を設置した場所が分かるように、アンテナ
設置点の直下に杭等の目印を打ちつけておくと良いでしょう。次回から、ローカル基準局のスタティック
測位のための 1時間の観測時間を省略することができます。

3. 対空標識の設置
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　GNSS観測の方法は、2.2項で説明した通り用意できる GNSS受信機の数によって【A】～
【C】の 3通りに分けられます。

4.1　GNSS 観測手順

　【A】「GNSS受信機が 1台の場合」における、「電子基準点を基準局として、スタティック
測位による基線解析で移動局の位置座標を算出する手順」は、【B】と【C】にも共通する基本
事項なので、必ず【A】の方法をお読みください。

【A】GNSS受信機が 1台の場合（【スタティック測位】）
　GNSS受信機が 1台の場合は、電子基準点を基準局として、移動局の位置座標をスタティッ
ク測位で計測します。以下の手順で対空標識を順番に移動しながら GNSS観測を行います。

　 1．対空標識の中心に GNSSアンテナを直接設置します（図 4-1右）
　 2．GNSS受信機の電源を入れてログデータの取得を開始します。
　 3．観測開始時刻をメモし、状況写真も撮影しておきます。
　 4．対空標識 1箇所当たりの観測時間は、最低 1時間を目安とします。
　　　＊観測中は自分自身が遮蔽物とならないように注意してください。
　 5．終了時間をメモし、電源をオフにします。
　 6．次の対空標識に移動し、1.～ 5.の手順を繰り返します。

　＊ どうしても周辺の建物や樹木の影響を受けそうな場所や、傾斜地でアンテナの水平を確保
しにくい場所については、巻末付録 C①を参考に三脚を用いた観測を行ってください。

【B】GNSS受信機が 2台の場合（【スタティック測位】→【キネマティック測位】）
　GNSS受信機が 2台ある場合は、以下の手順で GNSS観測を行います。

　（1）GNSS受信機 1台を空撮範囲内にローカル基準局として設置します。
　　 　設置方法・データ取得方法は【A】GNSS受信機が 1台の場合と同様で、スタティック
測位によりログデータを取得します。なお、（2）のすべての移動局の測位が終了した場
合でも、ローカル基準局については、最低 1時間を目安としてログデータの取得を継続
します。また、すべての移動局の測位の測位が終了していない場合はログデータの取得を
継続します。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）

4
小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）

GNSS 観測

 巻末付録Ａの機材（L1波のみ受信）では、キネマティック測位によるFIX解が全く得られない
ことが多々あります。L1波とL2波を受信できる上位機種の利用を推奨します。
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　（2）もう 1台の GNSS受信機は、移動局として以下の手順で各対空標識を観測します。

　 1．GNSS受信機の電源を入れてログデータの取得を開始します。
　 2．対空標識の中心に GNSSアンテナを直接設置します（図 4-1右）。
　 3．観測開始時刻をメモし、状況写真も撮影しておきます
　 4．対空標識 1箇所当たりの観測時間は、3～ 5分を目安とします。
　　＊観測中は自分自身が遮蔽物とならないように注意してください。
　 5． 観測が終了したら終了時間をメモ記録し、GNSS受信機の電源は入れたまま、次の対

空標識に移動します。
　 6．対空標識の数だけ、2.～ 4.の手順を繰り返します。
　 7．すべての対空標識の観測が終了したら GNSS受信機の電源をオフにします。

　＊ どうしても周辺の建物や樹木の影響を受けそうな場所や、傾斜地でアンテナの傾きが気に
なる場所が含まれる場合は、巻末付録 C②を参考に一脚を用いた移動観測を行ってくだ
さい。

　＊ 移動局の観測を行っている間も、ローカル基準局の電源はオンの状態にしておいてください。
　＊ 移動局の電源をオンにしてから、すぐ近くにある対空標識を測るとうまく Fix解が得られ
ない場合があります。移動局の電源をオンにした後は、受信機を持ったまま、対空標識の
設置状態の確認作業を兼ねて、観測対象圃場の周りをぐるっと 1周してから、対空標識
の GNSS観測を開始することをお薦めします。

【C】対空標識兼用 GNSS受信機が地上基準点の数だけある場合（【スタティック測位】）
　「対空標識兼用 GNSS受信機（巻末付録 A①）」を地上基準点の数だけ用意できる場合は、
設置と同時に観測機材の電源を入れておくだけで、各地点のログデータの取得が行えます。ド
ローンでの撮影が終了し、1時間以上のログデータを取得できたら、各受信機の電源をオフに
しながら回収します 12。

図 4-1　ローカル基準局の設置（左）、移動局での観測（右）

12  「対空標識兼用 GNSS受信機」もしくは「GNSSアンテナ収納可能な対空標識固定専用マット」を用いる
ことで、ドローン空撮と同時に GNSS観測が行えます。

4. GNSS 観測
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4.2　比高計測　（オプション：より精度を高めたい場合に実施）

　GNSS観測でも、高さ方向の座標値を得ることができますが、一般的に水平方向よりも精
度が劣ります。高さ方向の座標値の精度をより高めたい場合は、比高計測を追加実施するこ
とで、対空標識間の高さの違いをより正確に計測することができます。巻末付録 Dにおいて、
①水準（レベル）測量による方法と②回転レーザーによる方法の 2通りを説明します。使用
する機材に合わせて実施してください。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）



19

　現地での作業が終わったら、RTKLIBによる基線解析を行ない、ローカル基準局または対空
標識の座標値を算出します。

5.1　RTKLIB の準備と概要

　RTKLIBは、GNSS観測データの解析を行うためのオープンソースのライブラリとアプリ
ケーション群で高須知二先生（㈱ライトハウステクノロジー・アンド・コンサルティング、東
京海洋大学）によって開発・整備が進められています。OSはWindowsと Linuxに対応して
おり、表 5-1に示す各種アプリケーションが提供されています。本マニュアルでは、2～ 5の
Windows用の 4つのアプリケーションを使用します。

表 5-1　RTKLIBのアプリケーション一覧

Windows用（GUI） Linux用（CUI） 説　　明
1 rtklaunch.exe アプリケーションを起動するためのランチャ
2 rtkconv.exe convbin 観測データの各種形式を Rinex形式に変換する
3 rtkpost.exe rnx2rtkp 観測データから後処理により測位計算を行う
4 rtkget.exe 精密軌道や精密クロック情報をダウンロードする
5 rtkplot.exe 観測データや測位結果をプロットする
6 rtknavi.exe rtkrcv 観測データからリアルタイムで測位計算を行う
7 strsvr.exe str2str 観測データの生データを伝送する
8 srctblbrows.exe Ntripで提供されているデータを一覧表示する
9 pos2kml.exe pos2kml 測位結果を kmlに変換する

　Windows用のアプリケーションは、実行可能な .exeファイル形式で配布されているので、
インストール作業は不要です。取得方法の詳細は、巻末付録 Eを参照してください。

5.2　基線解析に必要なファイルの準備

　基線解析には、GNSS受信機による現地観測データの他に、電子基準点関連データ、ジオ
イドモデル、IGS精密歴データ（より精度を高めたい場合のみ）を別途インターネットからダ
ウンロードする必要があります。

①　電子基準点関連データ
　 　国土地理院の電子基準点データ提供サービス（http://terras.gsi.go.jp）から、電子基準点

GNSS観測データ、PCV補正データをダウンロードします。取得方法の詳細は、巻末付録
F①および②を参照してください。

4. GNSS 観測

RTKLIB による基線解析（座標値の算出）5
小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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②　ジオイドモデル
　 　基線解析の結果、座標値の高さ方向の情報は、楕円体高として出力されます。楕円体高
を標高に変換するにはジオイドモデルを使用します。基盤地図情報ダウンロードサービス
（https://fgd.gsi.go.jp/download）から、「日本のジオイド 2011」（Ver.2）をダウンロード
します。取得方法の詳細は、巻末付録 F③を参照してください。

③　IGS精密暦データ（オプション：より精度を高めたい場合のみ）
　　＊本データを使用しなくても、基線解析を行うことは可能です。
　 　IGS（International GNSS Service）が公開する GPS衛星の精密な軌道情報と衛星クロッ
クの補正情報を使用することで、結果の精度向上を期待することができます。ただし、IGS

精密暦データがインターネット上で公開されるまでのタイムラグがあり、GNSS観測日か
ら数日間経過しないと使用することができないというデメリットがあります。データのダウ
ンロードには、RTKLIBのアプリケーション（rtkget.exe）で行います。取得方法の詳細は、
巻末付録 F④を参照してください。

5.3　解析手順

　解析手順を図 5-1に示します。まず、①GNSS受信機からログデータを取り出します。次に、
②ログデータのファイル形式を rtkconv.exeでフォーマット変換します。そして③ rtkplot.exe

で観測データの品質を評価した後、④ rtkpost.exeで基線解析を行います。そして、再度、⑤
rtkplot.exeで解析結果の精度を評価します。最後に⑥Microsoft Excelで解析結果を整形し、
対空標識の座標値を算出します。

図 5-1　RTKLIBを使った GNSS観測データの解析フロー

① GNSS受信機からログデータの取り出し（P.21）

② rtkconv.exeによる観測データのフォーマット変換（P.21）

③ rtkplot.exeによる観測データの品質評価（P.23）

④ rtkpost.exeによる基線解析（P.25）

⑤ rtkplot.exeによる解析結果の精度評価（P.33）

⑥ Microsoft Excelによる解析結果の整形と座標値の算出（P.35）

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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①　GNSS受信機からログデータの取り出し
　 　GNSS受信機からのログデータの取り出し方法は、各機材のマニュアルを参照してくだ
さい。一部の機材については、巻末付録にある機材紹介文にログデータの取り出し方法を記
載しています。取り出したログデータは、対空標識の ID番号と対応するようにファイル名
を変更します 13。

②　rtkconv.exeによる観測データのフォーマット変換
　 　GNSS受信機から取り出したログデータを RINEX形式に変換します 14。rtkconv.exeによ
り GNSS観測データの共通フォーマットである RINEX（Receiver Independent Exchange 

Format）形式に変換します 15。

　＊ 対空標識兼用 GNSS受信機を使用した場合は、ログデータは .txt形式で保存されるので、
rtkconv.exeで変換する際には、事前にファイル拡張子を .txtから .ubxに変更しておき
ます。拡張子の表示方法は、巻末付録 A①を参照してください。

　（1） RTKLIBのアプリケーションから C:¥RTKLIB_bin-rtklib_2.4.3¥bin¥rtkconv.exeを起動
します 16。

　（2） 「RTCM,RCV RAW or RINEX OBS ?」右の「...」から変換したいログデータを選択し
ます（図 5-2上）。

　（3） 「Output Directory」にチェックを入れ「...」から変換後のファイルの保存先「C:¥RTKLIB_

workspace¥input¥RINEX¥」を指定します 17。（図 5-2上）。
　（4）「Format」を Autoから u-bloxに変更します。
　（5）「Options...」ボタンを押して開いたウインドウで以下の設定をします（図 5-2下）。
　　（ア）RINEX Versionを 3.02に変更します 18。
　　（イ）Satellite Systemsを GPS, Galileo, QZSS, BeiDouにチェックします 19。
　　（ウ）Observation Typesをすべてチェックします 20。
　　（エ）Frequenciesの L1のみチェックします 21。

13 例えば、対空標識 01.ubx, 対空標識 02.ubx　など。
14 ログデータは、受信機のメーカーごとに独自仕様のファイル形式で保存されています。
15 rtkplot.exeや rtkpost.exeのアプリケーションは、RINEX形式のデータを使用します。
16 C:¥ドライブ直下にプログラムを置いた場合。
17  事前に保存策のフォルダを新規作成する。指定しない場合は、ログデータと同じフォルダ内に保存されま
す。

18 RINEXのバージョンは電子基準点の提供データに合わせて Version 3.02を使用します。
19 Satellite Systemsは、受信していない衛星データは変換されません。
20  Observation Typesは、C（疑似距離）、L（搬送波位相）、D（ドップラー周波数）、S（信号強度）を出力
するように指定します。

21  本マニュアルで使用する機材は L1波のみに対応しているため、Frequenciesは L1波のみを変換するよう
に指定しています。

5. RTKLIB による基線解析（座標値の算出）
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　（6） 設定画面に戻り「Convert」ボタンを押すと出力フォルダに拡張子が .obsと .nav の
RINEX形式のファイルが保存されます 22。

　（7） 各対空標識で取得された GNSS観測データに対して（1）～（4）の作業を繰り返します。
ローカル基準局を設置する場合は、ローカル基準局のログデータも同様に RINEX形式
に変換します。

図 5-2　rtkconvの設定（上）。Options...の設定（下）

22 拡張子が .obsと .navのファイルには、それぞれ GNSS観測データと航法メッセージが記録されています。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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③　rtkplot.exeによる観測データの品質評価
　 　RTKLIBのアプリケーションから C:¥RTKLIB_bin-rtklib_2.4.3¥bin¥rtkplot.exeを使っ
て 23、受信衛星の数、配置、SNR（signal to noise ratio）を確認することで、観測データ
（.obs）の品質を評価します。

　（1） メニューの File > Open Obs Data... から、観測データ（.obs）を選択してファイルを
読み込みます 24,25（図 5-3）。

　（2） メニューの Edit > Options... から設定画面を開き（図 5-4）、「Satellite System」で、
GPS, GAL（Galileo），QZS（QZSS），BDS（BeiDou）にチェックを入れます。

　　　＊ 日本時間で表示したい場合は、「Time Format」を「h;m;s LT」に変更し（図 5-4）、
「Fit Horizontal」ボタン（図 5-3）を押して、日本時間のスケールで再表示します。

　（3） ツールバーで表示する周波数帯を L1に変更します。
　（4） ツールバーで表示する衛星を「G：GPS、E：Galileo、J：QZSS、C：BeiDou、ALL：全て」

の中から選択します。
　（5） ツールバーで表示するグラフを以下から選択します。
　　●　Sat Vis：衛星ごとの SNR（色で区分）の時間推移のグラフ
　　●　Skyplot：衛星ごとの位置と SNR（色で区分）の推移の図
　　●　DOP/NSat：衛星数と DOP（色で DOPの種類を区別）の時間推移のグラフ
　　●　SNR/MP/EL：衛星ごとの SNRとマルチパスと高度の時間推移のグラフ
　　●　SNR/MP-EL：各衛星の高度による SNRとマルチパスの推移のグラフ
　　●　MP-Skyplot：衛星ごとの位置とマルチパス（色で区分）の推移の図

　各グラフを見て、受信衛星の数、DOP、SNR26の値を確認します（図 5-5）。最低限、受信
衛星数は最低 5つ 27以上観測できているか、DOPが大きな値となっていないか、SNR28が
35dB以上で受信できている衛星は多くあるか、などを確認します 29。

23  rtkconv.exeから「Plot...」ボタンを押しても rtkplot.exeを起動できます。
24  同じフォルダにある同名の航法メッセージ (.nav)も自動的に読み込まれます。観測データと航法メッセー
ジのファイル名が同じでない場合や、それぞれ別のフォルダに保存されていたりする場合は、メニューの
File > Open Nav Data...から正しい航法メッセージファイルを指定した上で読み込んでください。

25  rtkconv.exeから「Plot…」ボタンを押して直接起動した場合は、すでに変換したデータが読み込まれます。
26 SNR、DOP、受信衛星数については、用語解説および 2.4項の補足説明を参照ください。
27 文献によっては、最低 4つ以上としているものもあります。
28 SNR値が 40dB以上だと理想的な受信状態です。
29  場合によっては、Options...の設定で Elevation Maskを 10～ 30°に変更するなど、解析の際の設定値を
検討してみても良いでしょう。

5. RTKLIB による基線解析（座標値の算出）
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図 5-4　rtkplotのオプション設定

図 5-3　rtkplotに観測データを読み込んだ状態

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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④　rtkpost.exeによる基線解析
　 　GNSS観測データに問題がなければ、C:¥RTKLIB_bin-rtklib_2.4.3¥bin¥rtkpost.exeで基
線解析を行います。解析には、GNSS観測データの他に、5.2項で示した電子基準点（基準
局）の観測データ等も使用します。解析の手順や詳細は、2.2項で示した観測方法別に説明
します。まずは、【A】GNSS受信機が 1台の場合を一読し、【B】と【C】にも共通する基
本的な設定事項を確認してください。

【A】GNSS受信機が 1台の場合（移動局【スタティック測位】）
　 　電子基準点（基準局）と小型 GNSS受信機（移動局）の観測データを用いて、スタティッ
ク測位で基線解析を行います。

図 5-5　 Sat Visの表示（上）。Skyplotの表示（下）

5. RTKLIB による基線解析（座標値の算出）
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　（1） RTKLIBのアプリケーションから rtkplot.exeを起動します。
　（2） メイン画面の「Options...」ボタンを押して開いたウインドウで以下の設定をします。

なお、示した箇所以外の設定は、すべてデフォルトの設定です 30。

　　Setting1タブ
　　●　Positioning Mode：Staticを選択します。
　　●　Frequencies / Filter Type：L1を選択します。
　　●　Elevation Mask：10を選択します。
　　●　 （オプション：IGS精密暦データを使用する場合のみ） Satellite Ephemeris/Clockを

Preciseに変更します。
　　●　 SNR MASK：Roverと Base Stationにチェックを入れて、L1の行に 35を入力しま

す 31。
　　●　使用する衛星：
　　　　◇　 GNSS受信モジュールの型番が u-blox Neo-M8Tの場合（対空標識兼用 GNSS

受信機を含む）は、GPS、Gallileo、QZSS, BeiDou32にチェックを入れます 33。

30  使用する受信機や受信状況によって、解析に使用する衛星を変更すると解析結果の精度が変わる場合があ
ります。精度が出ない場合は、設定を変更してみてください。

31 Elevataion Maskと SNR MASKは、受信状況により値を調整してください。
32 Fix率が悪い場合は、Galileoのチェックを外した上で再解析を試してください。
33  BeiDouは、現時点（2019年 1月）においては電子基準点で観測を行っていないので、【A】GNSS受信
機が 1台の場合では、BeiDouの受信データが解析結果に反映されません。【B】と【C】のローカル基準
局を設置する方法は、ローカル基準局と移動局の間の基線解析に BeiDouのデータを使うことができます。

図 5-6　rtkpostのオプション設定（Setting1）

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　　Setting2タブ
　　●　Integer Ambiguity Res：GPSは「Continuous」34、BDSは「ON」を選択します。 

　　Outputタブ
　　●　Datum/Height：Geodeticを選択します 35,36。
　　●　Geoid Model：GSI2000（1x1.5″）を選択します。
　　＊  GNSS受信機を 2台以上使う【B】【C】の方法で、「ローカル基準局」の「楕円体高」

を求める場合にのみ、Ellipsoidalを選択します。

図 5-7　rtkpostのオプション設定（Setting2）

図 5-8　rtkpostのオプション設定（Output）

34 解析結果で Fix解が安定しない場合は、「Fix and Hold」に変更してみてください。
35  Datum/Heightの設定を「Geodetic」に変更することで、解析結果の高さが標高値で出力されます。
「Ellipsoidal」の場合は、楕円体高が出力されます。

36  RTKLIB ver2.4.2では、最新のジオイドモデルが一部正常動作しない地域があるという情報があります。
RTKLIB ver2.4.3についても、そのような不具合がある場合は、Datum/Heightの設定を「Ellipsoidal」に
変更し、楕円体高のまま座標値を算出してください。巻末付録 I①を参照して、楕円体高から標高へ変換
します。または、Geoid Modelを「Internal」に変更してみてください。

5. RTKLIB による基線解析（座標値の算出）
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　Positionsタブ（図 5-9）
　　Rover

　　●　 「対空標識兼用 GNSS受信機」を用いた場合、もしくは、対空標識の表面に GNSS

アンテナを直接設置した場合は、Antenna Type：チェックを外します。
　　●　 対空標識の直上（数十センチから数メートル）離れた場所に、三脚などを使って

GNSSアンテナを固定した場合は、Antenna Type：チェックを入れます。さらに、
Delta-E/N/U（m）：3つめのボックスに巻末付録 Cで計測したアンテナまでの高さを
入力します 37。＊対空標識ごとにアンテナの高さが異なる場合は、毎回この部分を変
更します。

　　Base Station

　　●　 電子基準点の座標表記を、Lat/Lon/Height（deg/m）に変更します 38。
　　●　 付録Ｆ③の手順（8）で調べた電子基準点の位置座標情報を「北緯（DEG表記）」、「東

経（DEG表記）」「楕円体高」の順に記入します。付録Ｆ③の手順（9）で、電子基準
点の位置座標情報を管理するファイル（Position File [.pos]）をすでに作成している
場合は、「Station Position File」右横の「…」アイコンをクリックし、Position File

を選択します。次に「Base Station」 右側の「…」アイコンをクリックすることで、
図 5-9右側パネルが開かれ、目的の電子基準点をマウスで選択し、「OK」をクリック
することで、電子基準点の座標情報が「Options」パネルに反映されます。

　　●　 Antenna Type：チェックを入れて、ボックスに「＊」を入力します。

図 5-9　rtkpostのオプション設定（Positinos）

37  RoverDelta-E/N/U(m)に入力した値が、解析した座標値（アンテナの位置）から差し引かれて解析結果と
して出力されます。対空標識の高さとアンテナの高さが異なる場合に使用します。

38  BaseStationの設定を「RINEX Header Position」に変更することで、電子基準点の観測データファイル
に格納された、電子基準点の座標情報を自動インポートすることができます。ただし、「RINEX Header 
Position」による座標情報の精度が悪いため、地図と重ねたときの位置ズレの原因となります。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　Filesタブ
　　●　 Sattellite/Receiver Antenna PCV File：上から 2つめのボックスに電子基準点の PCV

補正データのファイル（巻末付録 F②）を指定します。
　　●　 Geoid Data File：ジオイドモデルのファイル（巻末付録 G）を指定します。

　メイン画面
　　●　 Time Start（GPST），Time End（GPST），Intervalのチェックが外れていることを

確認します 39。
　　●　 RINEX OBS：Rover：rtkconv.exeで RINEX形式に変換済みの対空標識の観測ファ

イル（5.3項②）を指定します。
　　●　 RINEX OBS：Base Station：電子基準点の観測ファイルを指定します（巻末付録 F①）40。
　　●　 RINEX ＊NAV/CLK,SP3,IONEX or SBS/EMS：1つめのボックスに rtkconv.exeで

RINEX形式に変換した際に作成された航法メッセージファイル（拡張子 .nav）を指
定します。

　　●　 （オプション：さらに精度を高めたい場合のみ）2つめのボックスに IGSの精密暦デー
タ等（拡張子 .sp3, .clk）（巻末付録 H）を指定した後、ボックスの拡張子を「＊」に
変更します 41。

　　●　 Solution：チェックを入れて、Dirに解析結果を保存するためのフォルダを指定します。

図 5-10　rtkpostのオプション設定（Files）

39  Time Start (GPST), Time End (GPS)にチェックを入れ、開始時刻（UTC：協定世界時）と終了時刻を入力
することで、基線解析に用いる移動局の GNSS観測データ期間を限定することができます。

40  電子基準点の観測ファイルを複数入力する必要のある場合は、複数の観測ファイルを 1つのフォルダに入
れ、ファイル名を「＊.18o」に変更します。同じフォルダ内にある「.18o」で終わるファイルすべてを指
定することになります。

41  IGSの精密暦データを指定しなくても解析は可能です。解析結果を見て精度的に必要かどうか判断すると良い
でしょう。精密暦のファイルを複数入力する必要のある場合は、ファイル名を「igr＊」に変更します。「＊」は
ワイルドカード指定なので、同じフォルダにある「igr」から始まるファイルすべてを指定することになります。

5. RTKLIB による基線解析（座標値の算出）
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　（3） すべての設定が完了したら、「Execute」ボタンを押して解析を開始します。画面の下部
に処理中のメッセージが表示され、Q=1（Fix解）の表示が続けば上手く解析ができ
ています 42。解析結果は、指定したフォルダの中に拡張子「.pos」で保存されます 43。

図 5-11　rtkpostの設定（メイン画面）

図 5-12　rtkpostの解析実行中の画面

42  処理中のメッセージで Q=5が続く場合は、解析が上手くできていません。原因として、基準局の観測ファ
イルの時間帯と移動局の観測ファイルの時間帯がオーバラップしていない可能性があります。日本標準時
間および協定世界時間 (UTC)の違いに注意するなどして、基準局と移動局の観測時間帯がオーバラップし
ていることを確認してください。また、Q=1が続かず Q=2が頻繁に表示される場合は、観測状況が良くな
かった可能性があります。5.3項⑤の解析結果の精度評価を行うことで原因が特定できるかもしれません。

43  5.3項⑥で説明するMicrosoft Excelにより処理を経て、「.pos」ファイルから最終的な座標値（緯度，経
度， 標高）が算出されます。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　（4） メイン画面の「KML/GPX...」ボタンを押して KML/GPX Converterを起動します。ラ
ジオボタンで出力ファイルの種類を選択します。「Convert」ボタンを押すとOutputボッ
クスのファイル名で、測位解の位置をプロットした KMLまたは GPXファイルが作成
されます 44。

【B】 GNSS受信機が 2台の場合（ローカル基準局【スタティック測位】→移動局【キネマ
ティック測位】）

　GNSS受信機が 2台ある場合は、まず、電子基準点とローカル基準局の観測データを対象
に、スタティック測位による基線解析を行い、ローカル基準局の座標値を算出します。次に、
ローカル基準局と各対空標識（移動局）の観測データを対象に、キネマティック測位による基
線解析を行います 45。

Ⅰ．電子基準点とローカル基準局間の基線解析（スタティック測位）
　 　基本的な解析の流れは【A】GNSS受信機が 1台の場合と同じですが、以下に示す

rtkpost.exeの設定項目が異なります。

　　●　 Outputタブの Datum/Heightを「Ellipsoidal」に変更します 46。Positionsタブの
Roverの AntennaTypeのチェックを外します。

図 5-13　KML/GPX Converter

44  kmlファイルは、5.3項⑤で説明する解析結果の評価に利用することができます。GPXファイルは、
ArcGISや QGISなどの GISソフトウェアで読み込むことができます。

45  ローカル基準局と移動局の距離は近い（基線ベクトルが短い）ため、短時間で精度の良い解析が行えます。
ただし、ローカル基準局の座標値の精度が、移動局すべてに影響します。また、電子基準点では、Beidou
からの信号を受信していませんが、対空標識兼用 GNSS受信機を使えば、ローカル基準局と移動局ともに
Beidouの衛星を受信できているので、キネマティック測位による基線解析に Bediouのデータを利用でき
るメリットがあります。

46  この設定によって、解析結果のローカル基準局の座標値は、アンテナ位相中心の位置となり、高さは楕円
体高で出力されます。

5. RTKLIB による基線解析（座標値の算出）

 巻末付録Ａの機材（L1波のみ受信）では、キネマティック測位によるFIX解が全く得られない
ことが多々あります。L1波とL2波を受信できる上位機種の利用を推奨します。
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　　●　メイン画面の RINEX OBS:Roverでローカル基準局の観測データを入力します。

　解析実行後、5.5項に進み、ローカル基準局の座標値（緯度，経度，楕円体高 [Ellipsoidal]）
を確定します。ローカル基準局の座標値は、移動局（対空標識）とのキネマティック測位によ
る基線解析に使用します。

Ⅱ．ローカル基準局と移動局（対空標識）間の基線解析（キネマティック測位）
　【A】の解析手順（P.25）と同じ流れですが、以下に示す設定項目を変更した上で行います。
　　●　Positioning Modeを Kinematicに変更します。
　　●　 移動局の GNSSアンテナを一脚などで固定した場合、Positionsタブの Roverの

Delta-E/N/U（m）の 3つ目のボックスに一脚に GNSSアンテナを取り付けたときの、
一脚の足先から GNSSアンテナのグランドプレーンまでの高さ（固定値）を入力し
ます 47。

　　●　 Positionsタブの Base Stationを Lat/Lon/Height（deg/m）に変更し、ボックスに I.で
算出したローカル基準局の座標値（DEG表記）を入力します。3つめのボックスに
楕円体高を入力します。

　　●　AntennaTypeのチェックを外します。
　　●　Filesタブの Sattellite/Receiver Antenna PCV Fileを空白に変更します。
　　●　メイン画面の RINEX OBS:Roverで移動局（対空標識）の観測データを指定します。
　　●　 メイン画面の RINEX OBS:Base Stationでローカル基準局の観測データを指定しま

す。
　　●　 メイン画面の RINEX ＊NAV/CLK,SP3,IONEX or SBS/EMSにローカル基準局の航法

メッセージファイル（.nav）を追加します。

　キネマティック測位は、移動する移動局の位置座標を測位する方法です。.posファイルを
rtkplot.exeで確認すると、移動局の軌跡が描かれます（図 5-14）。【A】の方法とは違って、
一つのファイルに記録された計算結果から、対空標識ごとの位置座標を切り分ける必要がある
ため、各対空標識に GNSSアンテナを設置した時の正確な開始・終了時刻メモが必要となり
ます 48。

47  アンテナを対空標識の表面に置いた場合は不要です。
48  現地観測の際にメモを取り忘れた場合は、rtkplot.exeで表示した移動軌跡にマウスカーソルを合わせるな
どして、開始時刻と終了時刻を読み取る作業が必要になります。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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【C】「対空標識兼用 GNSS受信機」が地上基準点の数だけある場合（スタティック測位）
　　この場合は、以下の 2通りの処理方法から 1つを選択します。

　C1） 【A】と全く同じ方法を GNSS受信機の数だけ繰り返し、電子基準点（基準局）と「対
空標識兼用 GNSS受信機」（移動局）間の基線解析をスタティック測位で解析します。

　C2） 【B】の方法の前半部と同様に、対空標識兼用 GNSS受信機の 1つをローカル基準局と
し、はじめに、電子基準点とローカル基準局間の基線解析をスタティック測位で行い、
ローカル基準局の座標値を確定する。その後、ローカル基準局の観測データと、その
他の対空標識兼用 GNSS受信機（移動局）をペアにしてスタティック測位で解析しま
す 49。

⑤　rtkplot.exeによる解析結果の精度評価
　 　rtlplot.exeで解析結果のデータ（.pos）を表示し、測位座標のプロット、誤差、変動など
を確認し、解析結果を評価します。RTKLIBのアプリケーションから rtkplot.exeを起動し、
以下の手順でデータを確認します 50。

　（1） メニューの File > Open Solution1... から、解析結果（.pos）を選択してファイルを読
み込みます（図 5-15）51。

図 5-14　キネマティック測位結果を rtkplot.exeで確認

49  移動局も固定された状態で 1時間以上の観測時間を確保できているため、【B】の方法とは異なり、スタ
ティック測位で基線解析を行うことができます。したがって、【C】（2）の処理のほうが、処理手順がやや
煩雑になりますが、ローカル基準局と移動局の基線ベクトルが短く、Static測位ができるため、より精度
の良い解析結果が得られると考えられます。

50  rtkpost.exeから「plot...」ボタンを押しても rtkplotを起動できます。
51 rtkpost.exeから直接起動した場合は、すでに変換したデータが読み込まれています。
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　（2） メニューの Edit > Options... から設定画面を開き、「Error Bar/Circle」で「Bar/Circle」
を選択します。

　（3） ツールバーで品質フラグ 52を選択します。Q1：Fixed、Q2：Float、Q4：DGPS、Q5：
Single、All：すべて

　（4） ツールバーで表示するグラフを以下から選択します。
　　●　Gnd Trk：測位座標のプロットと測位解の種類（色で区分）の図
　　●　Position：測位座標の東西、南北、上下の推移のグラフ
　　●　Velocity：測位座標の移動速度の東西、南北、上下の推移のグラフ
　　●　Accel：測位座標の加速度の東西、南北、上下の推移のグラフ
　　●　Nsat：有効衛星数、相対測位の時間差、Ratio Factor for AR Validationの推移グラフ 53

　（5） Gooogle Earth Pro （https://www.google.co.jp/earth/download/）を使って、rtkpost.

exeで作成した kmlファイルを読み込み、測位解の場所を確認します 54。

52  品質フラグの Q1：Fixedとは、干渉測位における搬送波の波数（整数値バイアス）が定まった状態（Fix解）
で、Q2：Floatは、整数値バイアスが定まっていない推測値の状態（Float解）を表しています。

53  Ratio Factor for AR Validationとは、整数値バイアスの妥当性を評価するための値で、最も良い候補と 2
番目に良い候補の確からしさの比率です。値が大きいほど、信頼性が高く、最高値は 999.9となります。

54  場所によっては、Google Earthの衛星画像の位置情報が必ずしも正確でない場合があるので、測位結果の
精度評価には使えません。異常値有無の確認程度にお使いください。

図 5-15　rtkplotに解析結果（.pos）を読み込んだ状態

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　（6） 各図やグラフを見て、正しい位置で測位解が Q1:Fixedとなっており、異常な結果になっ
ていないか確認します 55（図 5-16）。

⑥　Microsoft Excelによる解析結果の整形と座標値の算出
　 　解析結果（.posファイル）をMicrosoft Excelに読み込み、対空標識の座標値を算出する
方法を説明します。

　A）解析結果ファイルのMicrosoft Excelへの読み込み

　（1） Microsoft Excelを起動し、メニューの File > 開く > コンピューターから「参照」ボ
タンを押し、拡張子を「すべてのファイル（＊.＊）」に変更して、解析結果（.pos）
「C:¥RTKLIB_workspace¥output¥対空標識 01.pos」を選択します（図 5-17）。

　（2） テキストファイルウィザードが表れます。「スペースによって右または左に揃えられた
固定長フィールドのデータ」を選択し、「取り込み開始行」を 25、「先頭行をデータの
見出しとして使用する」にチェックを入れ「次へ」を押します（図 5-18）。

　（3） 区切り位置を各数値の後ろの以下の列 10、23、38、53、64、68、72、81、90、99、
108、117、126、133、140に設定し「次へ」を押します（図 5-19）。

　（4） 1列目を選択し「日付 YMD」に変更します。2列目を選択し「文字列」に変更します。
3列目以降はそのまま「G/標準」にします（図 5-20）。

　（5）Microsoft Excelに取り込めたら Excelブック（.xlsx）で保存します。

図 5-16　Positionのグラフを表示

55  rtkplot.exeのツールバーにある「Google Earth View」と「Google Map View」は、現時点（2019年）で
は使用できなくなっています。
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図 5-17　Microsoft Excelで .posファイルを開く

図 5-18　テキストファイルウィザードの設定 1

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 5-19　テキストファイルウィザードの設定 2

図 5-20　テキストファイルウィザードの設定 3

5. RTKLIB による基線解析（座標値の算出）
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　Microsoft Excelに取り込んだ各列の情報は以下のようになっています。

A 列（%GPST）：観測年月日（GPS時間）
B 列（空白）：観測時刻（GPS時間）
C 列（latitude（deg））：緯度（WGS84）
D 列（longitude（deg））：経度（WGS84）
E 列（height（m））：高さ（楕円体高もしくは標高。rtkpostでの設定による）
F 列（Q）：品質フラグ（Q1：Fixed、Q2：Float、Q4：DGPS、Q5：Single）
G 列（ns）：有効衛星数
H 列（sdn（m））：座標値の南北方向の標準偏差
I 列（sde（m））：座標値の東西方向の標準偏差
J 列（sdu（m））：座標値の上下方向の標準偏差
K 列（sdne（m））：座標値の南北 -東西方向の標準偏差
L 列（sdeu（m））：座標値の東西 -上下方向の標準偏差
M 列（sdun（m））：座標値の上下 -南北方向の標準偏差
N 列（age（s））：相対測位（固定局 -移動局間）の時間差
O 列（ratio）：整数値バイアスの妥当性を評価するための値（最も良い候補と 2番目に良い
候補の確からしさの比率）

＊ 【B】GNSS受信機 2台の場合（ローカル基準局【スタティック測位】と移動局【キネマ
ティック測位】）は、対空標識ごとにデータを切り分ける必要があります。方法は次の通
りです。

　（1） 対空標識の数だけ、Microsoft Excelファイル内に新たなタブを作成します。新規作成
されたタブの名前を対空標識の ID番号に変更します。

図 5-21　 Microsoft Excelに取り込んだ解析結果

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　（2） 現地調査でメモを取った各対空標識の観測開始・終了時刻を参考に、各対空標識の観
測時刻の一致する行を新規作成したタブにコピーします 56。

　B）座標値の算出 57

　 　解析結果の中から品質フラグが「Fix（Q=1）」となった行を抽出し、それらの緯度、経度、
高さの「中央値（MEDIAN）」を計算し、最終的な対空標識の座標値を確定する方法を説明
します。

　（1） 1行目（タイトル行）を選択して、メニュー > データの中の「フィルタ」ボタンを押
します。

　（2）F列（品質フラグの列）のフィルタで「1」だけを選択します。
　（3） C列（緯度の列）の最終行の次の行に以下の数式を入力します。XXXには最終行の番

号を入れます。

　　　　=AGGREGATE（12,5,C2:CXXX）

　　　　※ AGGREGATEは集計値を求める関数です。
　　　　※ 最初の引数では、集計方法を中央値（MEDIAN）に指定します。
　　　　※ 2番目の引数では、非表示の行を無視する設定にします。
　　　　※ 3番目の引数では、集計範囲を指定します。

　（4） 数式を D列（経度）と E列（高さ）にコピーします。
　（5） C列、D列、E列で集計された値が、それぞれ対空標識の緯度、経度、高さ（標高また

は楕円体高）になるので値をコピーして、テキストファイルに保存します。

56  GPS時刻は、協定世界時（UTC）で表されるので、現地調査メモと照らし合わせる際には、時差（9時間）
を考慮する必要があります。GPS時刻（協定世界時）＝日本時間－ 9時間

57  座標値の算出方法は、ここで説明した方法の他に、集計方法を平均値とする方法や、F列（品質フラグの
列）が 1となる最後の行の値をそのまま座標値とする方法もあります。本マニュアルでは、GNSS受信ア
ンテナの傾きや設置環境等により、Fix解が安定しない場合を想定して、中央値を使う方法を紹介してい
ます。

5. RTKLIB による基線解析（座標値の算出）
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図 5-22　座標値の算出
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　対空標識の測位結果を Agisoft PhotoScan58に反映する方法を説明します。

6.1　Agisoft PhotoScan での事前処理

　ドローン空撮画像のインポートなどを含む Agisoft PhotoScanでの作業手順については
「ドローンを用いたほ場計測マニュアル（不陸（凹凸）編）」を参考にし、4章 4.2項「②マー
カーの配置」までの処理を実施してください。

6.2　対空標識（マーカー）の座標を入力

　Microsoft Excelによる処理で確定した対空標識の座標値を、メモ帳などのテキストエディ
タで以下のように CSV形式で入力（コンマ区切り）して保存し、ファイル名の拡張子を .txt

から .csvに変更します 59。

　LABELの列は、配置したマーカー 60の名前と同じになるように入力します 61。LAT列、
LON列に、GNSS観測で算出した緯度と経度を入力します。H列は、標高を入力しますが、
比高計測を実施している場合は、巻末付録 D③を参考に比高計測を反映した値を入力します。
また、ローカル基準局のように座標値の高さを楕円体高で出力している場合は、巻末付録 I①
を参考に標高に変換した値を入力します。

6.3　QGIS による座標系の変換（WGS84 →　平面直角座標系）

　QGIS（https://www.qgis.org/ja/site/）を使って位置座標の座標系をWGS84（単位：緯度
経度）から平面直角座標系（単位：メートル）に変換する方法を説明します 62。

LABEL,LAT,LON,H
point 1,38.062092275,140.920115374,12.5784
point 2,38.062087897,140.920226422,10.8979
point 3,38.062336903,140.920527909,3.2550
以下、ポイントの数だけ入力

58  Agisoft PhotoScanは、2018年末のメジャーアップデート時に Agisoft Metashapeへと名前が変わりま
した。Agisoft Metashapeへにおける対空標識の座標情報の入力方法については、Agisoft Metashapeの
マニュアルをご覧ください。

59 Microsoft Excelを使ってデータ入力し、CSV形式で保存する方法でも構いません。
60  マーカーとは、Agisoft PhotoScanの処理画面上で対空標識の中心位置を指し示す目印です。詳しくは、
「ドローンを用いたほ場計測マニュアル（不陸（凹凸）編）」の 4章 4.2項を参照してください。

61  Agisoft PhotoScanで使用されるデフォルトのマーカー名は、pointと数字の間にスペースが入っているの
で注意してください。

6. Agisoft PhotoScan への対空標識の座標情報の反映方法Agisoft PhotoScan への対空標識の
座標情報の反映方法6
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　＊ ドローン空撮画像の座標系を緯度、経度（WGS84）のままで良い場合は、6.4項に進ん
でください。

　＊  WEB上で 1点ずつ手入力する必要がありますが、国土地理院の「平面直角座標系への換
算サイト」において簡単に変換することができます（巻末付録 I②）。

　（1） QGISを起動しメニューからレイヤ > レイヤの追加 > デリミティッドレイヤの追加を
選択します（図 6-1）。

　（2） 開いたウインドウで以下の設定をして、「追加」ボタンを押します（図 6-2）。
　　●　ファイル名の「...」でマーカーの CSVファイルを指定します。
　　●　「エンコーディング」を「System」に変更します。

図 6-1　QGISを起動して、デリミティッドレイヤの追加を選択

図 6-2　デリミティッドレイヤの設定

62  古いバージョンの Agisoft PhotoScanでは、マーカーの座標値が緯度、経度となっていても、Agisoft 
PhotoScan上で平面直角座標系などに投影変換してオルソ画像や demデータを出力できました。Agisoft 
PhotoScan ver1.4.4では、読み込んだマーカ（GCP）の座標系から投影変換できなくなっているため、
QGISを用いた変換方法を説明します。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　　●　 「レコードとフィールドのオプション」で「最初のレコードはフィールド名を保持し
ている」「フィールドタイプを検出する」にチェックが入っているのを確認します。

　　●　 「ジオメトリ定義」で「Xフィールド」に LON、「Yフィールド」に LATが指定され
ているのを確認します。

　　●　 「ジオメトリの CRS」を「EPSG:4326 – WGS 84」を指定します。
　（3） QGISに追加されたレイヤを右クリックして エクスポート > 地物の保存 ...を選択します。
　（4）開いたウインドウで以下の設定をして、「OK」ボタンを押します（図 6-3）。
　　●　「形式」を「カンマで区切られた値 [CSV]」に変更します。
　　●　「ファイル名」に変換後のファイル名を指定します。
　　●　「CRS」を対象地域に該当する平面直角座標系を指定します。
　　●　「エンコーディング」を「System」に変更します。
　　●　「レイヤオプション」の「GEOMETRY」を「AS_XY」に変更します。

　保存されたファイルをメモ帳などで開くと、以下のように X列、Y列に平面直角座標系の
座標値が確認できます。

図 6-3　デリミティッドレイヤの設定

X,Y,LABEL,LAT,LON,H
7615.0880187,-215113.881599104,point 1,38.062092275,140.920115374,12.5784
7624.83289069002,-215114.358393259,point 2,38.062087897,140.920226422,10.8979
7651.26232683101,-215086.697289129,point 3,38.062336903,140.920527909,3.255
以下、ポイントの数だけ入力

6. Agisoft PhotoScan への対空標識の座標情報の反映方法
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6.4　対空標識（マーカー）の座標をインポート

　　●　 「ドローンを用いたほ場計測マニュアル（不陸（凹凸）編）」の 4章 4.2項④を参考に、
Agisoft PhotoScanの座標データペインの「インポート」ボタンを押して、対空標識
（マーカー）の座標値を記録した csvファイルを選択します。

　　●　 ウインドウが開くので（図 6-4）、「座標系」を「WGS84（EPSG::4326）」または「平
面直角座標系」を指定します 63。「区切り」でコンマを選択、「列」で対応する列番号
を入力します。

　　●　 座標系に「WGS84（EPSG::4326）」を選択した場合は、「東経」には「LON」を、
「北緯」には「LAT」を指定します。

　　●　 座標系に「平面直角座標系」を選択した場合は、「東経」には変換後の座標値の「X」を、
「北緯」には同じく「Y」を指定します。

　　●　 「列のインポートを開始」は、1行目の列名が入っているため、2を入力します。
「OK」ボタンを押すと座標データパネルのマーカー一覧に座標がインポートされま
す。

　以降の処理は、「ドローンを用いたほ場計測マニュアル（不陸（凹凸）編）」の 4章 4.2項
「⑤カメラを最適化」からと同様ですので、そちらを参照してください。

図 6-4　マーカーの座標を CSVからインポート

63  平面直角座標系を使う場合は、系番号を間違わないようにしましょう。
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　●　「RTKLIB ver.2.4.2 Manual」高須知二
　　　http://www.rtklib.com/prog/manual_2.4.2.pdf

　●　 「RTKLIBによる解析（JGU夏の学校 2018Ver.）」内山庄一郎、高精細地形情報取得の
ためのオープン教材

　　　https://hdtopography.github.io/learning/book/GNSS/

　●　 「測位衛星技術株式会社（2016）GNSSの基本知識 Version1.0」測位衛星技術株式会
社

　　　 http://gnss.co.jp/wp-content/uploads/2016/07/ddd790b4eae745d43594c4f30

2b14761.pdf

　●　 「トランジスタ技術 2018年 1月号」CQ出版社
　●　 「トランジスタ技術 2019年 2月号」CQ出版社
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の簡易・高精度測位手法に関する事例研究」　坂本利弘、岩崎亘典、石塚直樹、David S. 

Sprague　日本リモートセンシング学会誌 2019 
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　付録 A.　GNSS観測機材　

①対空標識兼用 GNSS受信機注 1

　機能・特徴
1．現場での利便性・汎用性を考えて、農研機構がデザインしました（特許出願中）。
2．搭載 GNSSモジュール：u-blox NEO-M8T

3．GNSSアンテナ：Tallysman TW2710

4．そのまま設置するだけで、対空標識としても使えます。
5． GNSSアンテナは簡単に取り外し可能（磁石固定）。三脚への取り付けや直接地面に設
置するなど、様々な場面で活用できます。（図 A① -1, 図 A① -2, 図 A① -3）。

6． 印刷可能なマグネットシートを簡単に貼り付けることができるので、対空標識としての
模様・色を自由に変更することができます（図 A① -4）。

　　＊ マグネットシート（株式記会社マグエックス販売「ぴたえもんレーザー屋外用　
A3」）への原稿作成・印刷・カットは、自分で行う必要があります。

7．面倒な設定不要。電源スイッチ一つでログデータの記録開始。
8．単 3アルカリ電池 4本で駆動。
　　＊ ニッケル水素充電池　エネループプロにでも駆動することを確認していますが、充電

池の劣化や不十分な充電によっては、機器が途中宇停止するリスクがあります。
9．microSDカードに記録
10． IPX等は取得していませんが、密閉性の高いケースなので小雨程度ならば内部の電子基
板をガード

図 A① -1　対空標識兼用 GNSS受信機（外観）

付録

 現場での利便性・汎用性を考えたデザイン。　　　　　　　　　　　　　　　　　　　　　　　　
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図 A① -2　対空標識兼用 GNSS受信機（内部）

図 A① -3　対空標識の計測（左）、グランドプレーン（巻末付録 E）を使用して三脚に搭載（右）

図 A① -4　マグネットシートに印刷した対空標識の設置（左）
　　　　　  対空標識の上に GNSSアンテナを載せた様子（右）

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　ログデータの取り出し方法
　・microSDカードを本体から取り出し、パソコンで直接読み込みます。
　＊ ログデータを rtkconv.exeで変換する際には、拡張子を .txtから .ubxに変更しておきます。

Windows10で拡張子を表示するには、エクスプローラーから表示タブを開き「ファイル
名拡張子」のチェックを入れます（図 A① -5）。

　注 1：特許出願中

② Raspberry Pi型 GNSS受信機
　機能・特徴

1．搭載 GNSSモジュール：u-blox NEO-M8T

2．GNSSアンテナ：Tallysman TW2710

3．三脚に取り付けられるグランドプレーン付属
4． 面倒な設定不要。モバイルバッテリーから Raspberry Piに給電するとしばらくして、
受信を開始します。終了時は、Raspberry Piと GNSSモジュールをつなぐ USBコー
ドを外すだけ。

5．付属のモバイルバッテリーで駆動。
6．小型 USBメモリに記録
7．LCDモニタ付きで受信状況のチェック可能

図 A① -5　拡張子の表示と変更方法

付録

＊製作販売会社については、 農研機構 農業環境変動研究センターまでお問合せ下さい。
                           e-mail:  niaes_kouhou@ml.affrc.go.jp  TEL:029-838-8191
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　ログデータの取り出し方法
　　・小型 USBメモリを本体から取り出し、パソコンで直接読み込みます。

　＊ 本製品は、静岡大学情報学部　木谷友哉先生の公開する技術資料（http://kitanilab.

org/2017/12/09/how-to-build-rpi-rtk-gnss-logger/）をもとに制作したものです。Raspberry 

Piの設定に詳しい方なら、木谷先生の公開資料をもとに材料費のみで自作可能です。

③ Reach RTK

　機能・特徴
1．搭載 GNSSモジュール：u-blox NEO-M8T

2．小型 GNSSアンテナ付属
3．Intel Edisonで駆動
4．iPad等によるモバイル端末を使って行う設定が煩雑。
5． 現在は、本モデルの後継機である「Reach M+」が販売されていますが、技術基準適合
証明等を取得していない可能性があります（2018年 7月現在）。技術基準適合証明等
を受けていない電波を発する機器を国内で使用した場合、電波法違反になる恐れがある
ので注意が必要です。

6． ログデータの RINEX形式への変換は、emlid社の配布する RTKLIBプログラムを使用
します。

図 A② -1　Raspberry Pi型 GNSS受信機

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）

＊製作販売会社については、 農研機構 農業環境変動研究センターまでお問合せ下さい。
                           e-mail:  niaes_kouhou@ml.affrc.go.jp  TEL:029-838-8191
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　ログデータの取り出し方
　　iPad等からWiFi経由でログデータを取り出します。
　　詳しくは、EMLID社（https://docs.emlid.com/reach/）のドキュメントを参照。

　販売：EMLID社 （https://emlid.com/）

④パソコンを使用した GNSS観測ログデータの取得方法
　パソコンを使用して GNSS観測のログデータを取得する方法を紹介します。ログデータの
取得には、RTKLIBのアプリケーション「rtknavi.exe」を使用します。GNSS観測用のアンテ
ナと受信機は別途用意してください。受信機は、USB端子でパソコンと接続できるものを選
んでおきます。ここでは、u-blox社製の NEO-M8Tモジュールを搭載した受信機を例に説明
します（図 A④ -1）。

図 A③ -1　Reach RTK

図 A④ -1　NEO-M8Tモジュールをパソコンに接続して
　　　rtknaviで観測ログデータを取得している様子

付録
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　最初に、Ublox社のサイト（https://www.u-blox.com/ja/product/u-center）から受信機の
設定ソフト「u-center v18.11」をダウンロードしてインストールします。受信機をパソコン
と接続するとドライバーがインストールされます。
＊  Windows10の場合、COMポートとして認識されない場合があるので、その場合は、デバ
イスマネージャーを開き「センサー」の中にある u-blox GNSS Location Sensorを右クリッ
クしてドライバーの更新を選択します。「コンピュータを参照してドライバーソフトウェア
を検索」を選び「コンピュータ上の利用可能なドライバーの一覧から選択します」をクリッ
クし「USB シリアル デバイス」を選択します。「ポート（COM と LPT）」の中に「USBシ
リアルデバイス」があるのを確認し、COMポートの番号をメモします。

　次に、u-centerで受信衛星の設定をします。アンテナを受信機に接続しパソコンと接続し
てから u-centerを起動します。ツールバーの「connect」ボタンから COMポートを選択して
受信機を接続します（図 A④ -2）。メニューから View > Messages View　を選択します。開
いたウインドウのリストから UBX > CFG > GNSS（GNSS Config）をクリックし、右側の設
定画面で使用する衛星の Enableにチェックを入れます（図 A④ -3）。NEO-M8Tモジュール
は、BeiDouと GLONASSを同時に選択できないので注意してください。その後「Send」ボ
タンを押して設定を有効にします。さらに、UBX > CFG > CFG（Configuration）をクリック
し、右側の設定画面で「Save current configuration」を選択し、「Devices」からすべての項
目を選択（Shiftを押しながら選択）します（図 A④ -4）。「Send」ボタンを押すと設定が受
信機内に保存されます。

図 A④ -2　u-centerで受信機に接続

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）



53

図 A④ -4　u-centerで設定を保存

図 A④ -3　u-centerで受信衛星の設定

付録
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　rtknavi.exeで使用する設定ファイルをダウンロードします。RTKLIBの Githubのページ
（https://github.com/tomojitakasu/RTKLIB/）にアクセスし dataフォルダの中の設定ファイ
ル（.cmd）を保存します。各自の環境に合わせた設定ファイルを使用しますが、ここでは
UbloxのM8Tで Beidouを含めたデータを 1hzで出力する設定ファイルの「ubx_m8t_bds_

raw_1hz.cmd」を保存しておきます。ファイル名をクリックして「Raw」を押して表示され
たページを「ubx_m8t_bds_raw_1hz.cmd」という名前で「RTKLIB_bin-master」のフォルダ
の中の「data」フォルダに保存します。

　事前の準備ができたら、rtknavi.exeを起動します（図 A④ -5）。Rtknavi.exeは、観測デー
タからリアルタイムに測位計算を行うアプリケーションですが、ここでは観測ログデータの取
得のために使用します。
　「I」ボタンを押して、インプット情報に関する設定画面を開きます（図 A④ -6）。（1）
Roverの行にチェックを入れて、Typeを「Serial」、Formatを「u-blox」に変更します。Opt

の「...」を押して Portと Bitrateを環境に合わせて指定し「OK」ボタンを押します（図 A④
-7）。Cmdの「...」を押し「Commands at startup」「Commands at shutdown」にチェック
を入れます（図 A④ -8）。「Load...」ボタンを押して「ubx_m8t_bds_raw_1hz.cmd」を読み
込み「OK」ボタンを押します。インプット情報に関する設定画面で「OK」ボタンを押して
rtknavi.exeのメイン画面に戻ります。
　「L」ボタンを押して、ログ情報に関する設定画面を開きます（図 A④ -9）。（6）Roverの行
にチェックを入れて、Typeを「File」に変更し、Log File Pathsの「...」でログファイルの保
存先を指定します。拡張子は .ubxに変更します。「OK」ボタンを押して rtknavi.exeのメイン
画面に戻ります。
　「Options...」ボタンを押して、オプションの設定画面を開きます（図 A④ -10）。rtknavi.

exeに表示したい衛星をチェックしておきます。ここでは測位計算に使用する衛星（rtknavi.

exeに表示される）を選択するだけで、ログデータには、受信設定で指定した衛星データが入
ります。
　Rtknavi.exeのメイン画面で「Start」ボタンを押すと観測が始まりログデータが保存されま
す。「Stop」ボタンを押すと観測が終了します。保存されたログデータ（.ubx）は、rtkconv.

exeで変換し解析に使用できます。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 A④ -5　rtknaviのメイン画面

図 A④ -6　インプット情報の設定画面

図 A④ -7　ポートの設定画面

付録
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図 A④ -8　cmd設定ファイルの読み込み

図 A④ -9　ログ情報の設定画面

図 A④ -10　オプションの設定画面
GNSS受信機、アンテナ販売：海外インターネットサイト（https://www.csgshop.com/）

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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⑤ GNSSアンテナ収納可能な対空標識固定専用マット注 1

　機能・特徴
1．現場での利便性・汎用性を考えて、農研機構がデザインしました（特許出願中）。
2．マットに中心部に GNSSアンテナ（Tallysman TW2710）を収納可能。
3．マットの 4隅に直径 4mmのネジ穴があり対空標識を固定可能。
4．対空標識の 4隅に空けた穴にペグを通すなどして地面に固定。
5．布製の対空標識を簡単に取り換え可能。
　　＊対空標識の中心が GNSSアンテナの中心直上に一致するように設計。
　　＊いつでも新品の対空標識に交換可能（汚れ対策）。
　　＊取り付ける対空標識は、別途用意する必要があります。
　　＊ 巻末付録 J②にサンプル原稿を用意したので、大型プロッターをお持ちでない方は、

近くの印刷会社にご相談ください。
6．用途にあった様々なデザイン・色の対空標識 64を取り付け可能。
　　＊  Agisoft PhotoScan用の対空標識マークを印刷すれば、Agisoft PhotoScanの画像認

識機能で、対空標識の ID番号および中心点の場所を自動認識することができます。
Agisoft PhotoScan処理する際の対空標識の測位座標情報を入力する手間が軽減され
ます。

7．軽量な素材を使っているため一度に複数枚を持ち運び可能。
8． 布製の標識をアンテナ上部に被せるため、通常の使い方よりも受信状態は悪くなりま
す。

　注 1：特許出願中

図 A⑤ -1  GNSSアンテナ収納可能な対空標識固定専用マット　GNSSアンテナを収納（左）
 簡単に対空標識シートを交換できるので、多様な模様の標識に変更可能（右）

64  「対空標識固定専用マット」用の対空標識は、自分で付録Ｉの原稿を印刷して作成するか、製作販売元に
問い合わせするなど、別途用意する必要があります。

付録

＊製作販売会社については、 農研機構 農業環境変動研究センターにまでお問合せ下さい。
                           e-mail:  niaes_kouhou@ml.affrc.go.jp  TEL:029-838-8191

 現場での利便性・汎用性を考えたデザイン　　　　　　　　　　　　　　　　
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⑥ GNSSアンテナ用グランドプレーン
　機能・特徴

1．三脚や一脚に取り付けて観測する際に、多重反射波の影響を軽減するためのものです。
2． 磁石付きの GNSSアンテナ（Tallysman TW2710を含む。）であれば、簡単に取り付け
可能です。

3．裏面には、三脚等に取り付けるためのネジ穴があります。

　

図 A⑥ -1　GNSSアンテナ用グランドプレーン

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 B-1　衛星配置の確認

　付録 B.　衛星配置の確認方法

　GNSS観測を実施する時間と場所で、天空における衛星の配置は常に変化します。その配置
によっては、測位精度を確保することが難しい場合があるので、事前にそれを確認し、GNSS

観測の実施日を検討します。

（1） GNSS View Web版（http://app.qzss.go.jp/GNSSView/gnssview.html）にアクセスしま
す。

（2）「Region」と「City」を観測する場所に変更します。
（3）「Time」を観測する日時に変更します。
（4） 「Mask Angle」を 10～ 30°に設定します。（低仰角の衛星は、誤差が大きくなり解析では

使用しないため）
（5）「VIEW」を押して表示を更新します。
（6）「SELECT SATELLITE」で解析に使用する衛星を選択します。
（7）「DOP Information」で、HDOPと VDOP、Visible GNSSの値を確認します。
（8）「Timeline」のスライダーを動かし、前後の時間の状況も確認します。

付録
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　DOP（Dilution of Precision）とは、衛星配置による精度低下率のことで、数値が大きいほ
ど精度が低いことを表します。HDOPは水平方向、VDOPは垂直方向の精度低下率を示します。
一般的には 3.0以下は良好な値と言われていますが、DOPは精度の良さの基準値として使用
するのではなく、精度が確保できているかの参考値として使用するのが良いでしょう。
　Visible GNSSは、観測できる衛星の数と種類で、測位をするためには基準局と移動局で最
低 4つの同じ衛星を観測する必要があります。また、観測できる衛星の数が多いほど精度が
良くなります。なお、解析に使用する衛星の種類によっては、5つ以上の衛星の観測が必要と
なる場合もあります（GPSと BeiDouの組み合わせなど）。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　付録 C.　三脚および一脚の利用

①三脚を用いた GNSS受信方法（スタティック測位）
　周辺の建物や樹木の影響を受けそうな場所や、傾斜地でアンテナの傾きが気になる場所での
観測は、三脚を用いて以下の方法で行います。

（1） 三脚を設置しアンテナを取り付けます。アンテナはなるべく高く上げ、周辺の建物や樹木・
雑草の影響を受けないようにします。

（2） 対空標識の中心から鉛直方向にアンテナが位置するように、水準器を見ながら三脚の傾
きを調整します。三脚の下部から錘を垂らすと正確に対空標識中心とのずれが確認でき
ます。

（3） 対空標識からアンテナのプレート面までの高さをメジャー等で計測し記録します。
（4） GNSS観測機材の電源を入れてログデータの取得を開始します。
（5） 観測開始時刻をメモし、状況写真も撮影しておきます。
（6） 対空標識 1箇所当たりの観測時間は、最低 1時間を目安とします。
（7） 終了時間をメモし、電源をオフにします。

図 C① -1　三脚による GNSS観測機材の設置（左）、対空標識中心の確認（右）

図 C① -2　水準器で三脚の傾きを調整（左）、アンテナまでの高さの計測（右）

付録
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②一脚を用いた GNSS受信方法（キネマティック測位）
　周辺の建物や樹木の影響を受けそうな場所や、傾斜地でアンテナの傾きが気になる場所での
移動観測は、一脚を用いて以下の方法で行います。

（1） 一脚にアンテナを取り付け、高さを調整し固定します。
（2） 一脚の下部からアンテナのプレート面までの高さをメジャーで計測し記録します。この

作業は事前に行っておくと良いでしょう。
（3） 対空標識の中心に一脚を立て水準器を見て傾かないように手で固定します。
（4） GNSS受信機の電源を入れてログデータの取得を開始します。
（5） 観測開始時刻をメモし、状況写真も撮影しておきます
（6） 対空標識 1箇所当たりの観測時間は、3～ 5分を目安とします。
（7） 観測が終了したら終了時間をメモし、GNSS受信機の電源は入れたまま、次の対空標識

に移動します。
（8） すべての対空標識の観測が終了したら GNSS受信機の電源をオフにします。

図 C② -1　一脚による GNSS観測（左）、対空標識中心の確認（右）

図 C② -2　水準器で一脚の傾きを調整（左）、アンテナまでの高さの計測（右）

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　付録 D.　比高計測　（オプション：より精度を高めたい場合に実施）

①水準（レベル）測量による比高計測
　対空標識（地上基準点）で水準測量を実施します。水準測量では、対空標識の相対的な高さ
を計測します。水準測量には直接水準測量と間接水準測量がありますが、ここではより精度の
高い直接水準測量について説明します。「3対空標識の設置」で設定した対空標識の中間に測
量機器であるレベルを設置し、対空標識に立てた標尺（スタッフ）の値を読み、前視と後視の
値から高低差を計算します。なお、この方法では標尺の長さより高低差が大きい場合は 1回
で測定が出来ないため、複数回に分けて測定を行います。ベンチマークとなる対空標識の高さ
を 0として、すべての対空標識の高低差を計測し記録します。
　以下に、オートレベルを用いた詳細な測量の手順を示します。

（1） 2つの対空標識 Aと Bの間にレベルを水平に設置します。
（2） レベルから目盛りが読めるように対空標識Aに標尺を立て、前後にゆっくりと動かします。
（3） レベルをのぞき、標尺の目盛りを読みます（後視）。目盛りの数値が一番小さい時が、標

尺が水平になった位置になるので、その値を記録します。また標尺用の水平器を使用し
ても問題ありません。

（4） 反対側の対空標識 Bに標尺を立て、同様にして数値を読み（前視）、記録します。
（5） レベルを対空標識 Bと Cの間に移動させ、同様にして Bの値（後視）と Cの値（前視）

を読み記録します。
（6） この作業を繰り返し全ての対空標識の高低差および比高を算出します。
（7） 往復で計測することでより精度が高くなります。

図 D① -1　水準測量による計測方法の概念図

表 D① -1　水準測量の比高計算例

No 後視（m） 前視（m） 高低差（m） 比高（m）
A（ベンチマーク） 1.543 0 0

B 1.488 1.275 0.268 0.268

C 1.436 1.628 -0.140 0.128

D 1.276 0.160 0.288
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　図 D① -1と表 D① -1に具体的な例を示します。各対空標識で計測した後視と前視を表
J-1のように記録します。各対空標識間の後視と前視の差を計算し「高低差」の列に記録しま
す。また、ベンチマークでの高さを 0とした場合の相対高度を計算し「比高」の列に記録します。
No.Cの地点の場合、No.Bとの高低差は、1.488 - 1.628 = -0.140 になり、ベンチマークであ
る No.Aとの比高は、0 + 0.268 -0.140 = 0.128となります。

②回転レーザーによる比高計測
　水準（レベル）測量よりも、より簡便な回転レーザーを使用した計測方法について説明します。
この方法は計測エリアの中心に回転レーザー機器を据え付け、機器から水平に照射されたレー
ザーを読み取ることで各対空標識の高低差を計測する手法です。機種によりますがレーザーの
照射範囲が直径 600～ 800ｍと広いため、機器の据え付け回数が少なくなり作業時間は短縮
できますが、前項で説明した水準測量より精度は悪くなります。
　以下に測量の手順を示します。

（1）計測範囲の中心付近に回転レーザーを水平に設置します。
（2） レーザーの受光器を取り付けた標尺を対空標識に設置し、水平にした時の高さを読み取

ります。この作業を全ての対空標識で行い高低差を算出します。
（3） 計測範囲が広大で回転レーザーを複数個所に設置する場合は、同じ対空標識を数か所重

複して計測することで、読み取り誤差を少なくします。

図 D① -2　水準測量の様子

図 D② -1　回転レーザーによる計測方法の概念図

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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③ GNSS観測値への比高計測の反映方法
　GNSS観測で算出した標高に比高計測の結果を反映する方法を説明します。比高計測にお
いてベンチマークとした対空標識の標高（GNSS観測で算出した値）に比高計測で取得した
比高（巻末付録 Jを参照）を足し合わせた値を新たな標高とします。
　具体例を表 D③ -1に示します。比高計測で対空標識 1をベンチマークとした場合の相対高
度が「比高」の列に入っています。今、ベンチマークである対空標識 1の標高は、GNSS観
測によって 12.578と算出されているので、その値を基準として、各対空標識の比高を足し合
わせます。対空標識 4の場合は、12.578 + 0.742 = 13.320 が比高計測を反映した標高になり
ます。

表 D③ -1　GNSS観測で算出した標高に比高計測の値を反映する例

No 緯度 経度 標高 比高 比高計測を
反映した標高

対空標識 1
（ベンチマーク） 38.0620923 140.920115 12.578 0 12.578

対空標識 2 38.0620879 140.920226 10.898 -1.624 10.954

対空標識 3 38.0623369 140.920528 3.255 -9.235 3.343 

対空標識 4 38.0622124 140.920377 13.224 0.742 13.320

対空標識 5 38.0622747 140.920453 16.986 4.334 16.912

図 D② -2　回転レーザーでの測量の様子
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65  GNSS受信機の種類によっては、安定版の RTKLIB Version2.4.2p13では、rtkconv.exeなどのフォーマッ
ト変換がうまくいかない場合があるため、ここではベータバージョンの RTKLIB Version2.4.3b31を使い
ます。

66  ワークスペース用のフォルダ名・場所は、任意の名前・場所でもかまいません。

　付録 E.　RTKLIBのダウンロード方法

　RTKLIB のプログラムは、ホームページ（http://www.rtklib.com/）より入手します
（図 E-1）。安定版と開発版が公開されていますが、本マニュアルでは Version 2.4.3 b31を
ダウンロードします 65。リンク先の Githubのページで「Clone or download」ボタンを押し
「Download ZIP」を選択するとダウンロードが始まります（図 E-2）。圧縮ファイルを解凍す
ると「RTKLIB_bin-rtklib_2.4.3」フォルダが作成されるので、Cドライブ直下など自分の分
かりやすい場所に移動しておきましょう。Cドライブ直下に移動した場合、各種アプリケー
ションは「C:¥RTKLIB_bin-rtklib_2.4.3¥bin」フォルダの中にあります。また、解析用のワー
クスペースとして、「C:¥RTKLIB_workspace」「C:¥RTKLIB_workspace¥input」「C:¥RTKLIB_

workspace¥output」を新規フォルダ作成します 66。

図 E-1　RTKLIBホームページ 

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 E-2　RTKLIBのダウンロードページ
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　付録 F.　電子基準点関連データのダウンロード

①電子基準点の GNSS観測ファイル
　以下の手順でダウンロードします。

（1） 電子基準点データ提供サービス（http://terras.gsi.go.jp）にアクセスします。
（2） 「電子基準点　観測データ取得」をクリックし、ログインします。ユーザー登録していな

い場合は、新規登録を行ったのちログインします。（図 F① -1）
（3） ドローン計測圃場付近に地図の移動、拡大を行い、最も近い電子基準点をクリックしま

す 67（図 F① -2）。
　　＊ ドローン空撮圃場と電子基準点の距離を調べたい場合は、地図右上の「定規アイコン」

をクリックして計測します。
（4） クリックした電子基準点の局番号と局名称をメモしておき、ダウンロードボタンを押す

と、データダウンロード画面に遷移します（図 F① -2）。
（5） 以下の設定をした後、「任意時間のデータをダウンロード」ボタンを押します 68,69（図 F

① -3）。
　　①　時刻種別は JST（日本標準時）を選択します。
　　②　 ドローン計測圃場において GNSS観測を実施していた時間をカバーするように、開

始日時と終了日時を指定します。
　　③　衛星は GRJEを選択します。
　　④　RINEX verは、ver3.02を選択します。
（6） 開いたウインドウから、「観測ファイル」をダウンロードします（図 F① -4）。
（7） ダウンロードしたファイルは gzip形式で圧縮されているので、対応ソフトで解凍しま

す 70。解凍された観測ファイル（拡張子が「.o」）を新規作成したフォルダ（C:¥RTKLIB_

workspace¥reference）に保存しておきます。

67  基準局までの距離が長いと精度の良い結果が出ません。そのため、基本的にはドローンによる圃場計測を
実施する場所から最も近い場所に位置する電子基準点を基準局データとして利用します。ただし、観測時
間帯や衛星の配置によっては、2番目、3番目に近い電子基準点のデータを使った方が解析結果の精度が
良くなる場合があります。あまり精度が出ない場合は、それらの電子基準点の使用も検討してみてくださ
い。

68  7日以前のデータを取得する場合は、図 F① -3の下にある「1日毎のデータのダウンロード」から 1日単
位で開始日と終了日を指定してデータをダウンロードします。なお、時刻の種別は UTC（協定世界時）と
なるので、日本時間から 9時間差し引いた日時を指定します。

69  1日毎の電子基準点の受信データは、UTCの 1日毎に分割されて配布されます。日本時間で、12月 10日
の朝 8時より観測を開始すると、同時間帯の電子基準点の観測ファイルは、UTCベースでは、12月 9日
の 1日分のファイルと 12月 10日の 1日分のファイル、計 2ファイルが必要となります。rtkpost.exeで
2つの観測ファイルを入力する必要のある場合は、ファイル名の一部を「＊」を使って表現することで複数
指定することができます。

70  Windowsで gzip形式を解凍することのできるフリーソフトとしては「+Lhaca」や「7zip」などがあります。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 F① -1　電子基準点データ提供サービス

図 F① -2　電子基準点の選択
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図 F① -4　観測ファイルと衛星軌道情報ファイルのダウンロード

図 F① -3　電子基準点の観測データをダウンロード

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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②電子基準点の PCV補正データ 71

　以下の手順でダウンロードします。

（1） 電子基準点データ提供サービス（http://terras.gsi.go.jp）にアクセスします。
（2） 「各種データ（観測データ以外のデータや情報の取得）」をクリックします（図 F② -1）。
（3） 「PCV補正データ」をクリックします。ログインしていない場合は、ログインします（図

F② -2）。
（4） 「電子基準点 PCV補正データダウンロードはこちら」をクリックしてファイルをダウン

71  PCV（Phase Center Variation）補正データとは、電子基準点のアンテナの種類ごとに位相中心が異なる
ため、それを補正するための情報です。

図 F② -1　電子基準点データ提供サービス「各種データ」の選択

図 F② -2　PCV補正データの選択
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ロードします（図 F② -3）。
（5） ダウンロードされたファイルの名前が、GSI_PCV.txtとなっているので、GSI_PCV.pcv

に変更し、新規作成した任意フォルダ「C:¥RTKLIB_workshop¥input¥PCV」に保存して
おきます。

③電子基準点の正確な位置座標の取得
　以下の手順で検索・作成します。

（1）基準点成果等閲覧サービス（https://sokuseikagis1.gsi.go.jp/top.html）にアクセスします。
（2）「基準点検索入口」をクリックし、注意事項をよく読み「同意」します（図 F③ -1）。
（3）ドローン観測を実施する地域付近に移動、拡大します（図 F③ -2）。
（4） 「基準点閲覧メニュー」から「電子基準点」だけにチェックを入れます（図 F③ -2左側

パネル）。
（5） 「検索」ボタンを押すと、近隣の電子基準点が表示されます。
（6） 地図上の電子基準点アイコンをクリックして「詳細情報表示」を選択すると各種情報（図

F③ -2右側パネル）を閲覧できます 72。
（7） 詳細情報の基準点成果情報から「電子基準点名」、「電子基準点観測点番号」、「北緯」、「東

経」、「楕円体高」（標高ではない）をメモします。

図 F② -3　PCV補正データのダウンロード

72  ドローン観測試験地と基準局の距離が長いと良い精度の解析結果が得られません。そのため、基本的には
ドローン観測試験地から最も近い場所に位置する電子基準点を基準局データとして利用します。ただし、
観測時間帯や衛星の配置によっては、2番目に近い電子基準点のデータを使った方が解析結果の精度が良
くなる場合もありうるので、あまり精度が出ない場合は、2番目に近い電子基準点の使用も検討してみて
くだい。ドローン観測試験地から電子基準点までの距離は、図 F③ -2の地図パネル右上の「機能」→「計
測」ボタンを押すことで計測することができます。

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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（8） 以下の計算式を参考に、Microsoft Excel等で「北緯」、「東経」の DMS表記を DEG表記
に変換します。

　　例） つくば 3（DMS表記　北緯：36°06’13”.0866, 東経：140°05’10”.7347） 
　　　　DEG表記への変換式 

　　　　　北緯：36+6/60+13.0866/（60＊60）= 　36.1036351667

　　　　　東経：140+5/60+10.7347/（60＊60）= 140.0863151944

（9） 複数の電子基準点の位置座標情報を管理するファイル（Position File [.pos]）を使う場合は、
以下の方法を参考に Excelで作成します（図Ｆ③ -3）。

　　 1．Excelで　ファイル -> 新規 -> 空白のブックを作成します。
　　 2．図Ｆ③ -3を参考に、以下の情報を入力します。
　　　　　・Ａ行　北緯（DEG表記）
　　　　　・Ｂ行　東経（DEG表記）
　　　　　＊ Ａ行とＢ行については、セル幅を十分に広げた上で、「小数点以下の表示桁数を増

やす」ためのアイコンをクリックして、小数点以下 10桁を表示してください 73。

　　　　　・Ｃ行　楕円体高
　　　　　・Ｄ行　電子基準点観測点番号
　　　　　・Ｅ行　電子基準点名
　　 3． ファイル -> 名前を付けて保存 ->参照の順で、任意の保存先のフォルダに保存しま

す「C:¥RTKLIB_workspace¥input¥reference」。ファイルの種類は、「テキスト（タ
ブ区切り）（＊.txt）」を選択します（図Ｆ③ -4）。

　　 4． フ ァ イ ル 名 の 拡 張 子 を「.txt」 か ら「.pos」 に 変 更 し ま す「C:¥RTKLIB_

workspace¥input¥reference¥基準局一覧 .pos」。

73  この作業をしないと、変換されたテキストファイル (.txt)に記載されている緯度・経度の小数点以下の桁
数が少なくなり、精度が悪くなる原因となります。
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図 F③ -1　基準点成果閲覧サービスのトップページ

図 F③ -2　電子基準点の検索画面

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 F③ -3　Excelによる電子基準点の位置座標情報の管理ファイル作成

図 F③ -4　テキスト（スペース区切り）（＊.prn）で保存
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　付録 G.　ジオイドモデルのダウンロード

　以下の手順でダウンロードします。

（1） 基盤地図情報ダウンロードサービス（https://fgd.gsi.go.jp/download/）にアクセスします。
（2） 「ジオイドモデル」の「ファイル選択へ」をクリックします（図 G-1）。
（3） ASCII形式のデータのダウンロードから「gsigeo2011_ver2_asc.zip」をクリックします。

ログインしていない場合は、ログインします（図 G-2）。＊ログイン IDとパスワードは、
電子基準点データ提供サービスサイトで登録したものと同じです。

（4） ダウンロードしたファイルを解凍し、解凍されたフォルダ内の programフォルダの
中にある「gsigeo2011_ver2.asc」を、新規作成した任意フォルダ「C:¥RTKLIB_

workspace¥input¥geoid」にコピーしておきます。

図 G-1　基盤地図情報　ジオイド・モデルの選択

図 G-2　基盤地図情報　ジオイド・モデルのダウンロード

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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　付録 H．IGS精密暦データ（オプション：より精度を高めたい場合に使用）

　＊本データを使用しなくても、基線解析を行うことは可能です。
　IGS（International GNSS Service）という組織によって計算された GPS衛星の精密な
軌道情報と衛星クロックの補正情報をダウンロードします 74。データのダウンロードには、
RTKLIBのアプリケーションの一つである rtkget.exeを使用します。巻末付録 Eを参考に、事
前に RTKLIBが使える状態にしてから先に進んでください。

（1） RTKLIBの Githubのページ（https://github.com/tomojitakasu/RTKLIB/）にアクセスし
ます（図 H-1）。

（2） dataフォルダの中の「URL_LIST.txt」をクリックします（図 H-2）。
（3） 「Raw」をクリックして表示されたページを「URL_LIST.txt」という名前で保存します（図

H-3）。
（4） 新規作成した任意フォルダー「C:¥RTKLIB_workspace¥input¥IGR」に「URL_LIST.txt」

をコピーします（図 H-4）。
（5） RTKLIB のアプリケーションから C:¥RTKLIB_bin-rtklib_2.4.3¥bin¥rtkget.exe を起

動し、以下の手順で GPS衛星の精密暦と衛星クロックの補正情報をダウンロードし
ます（図 H-5）。（C:¥ドライブ直下にプログラムを置いた場合は、C:¥RTKLIB_bin-

rtklib_2.4.3¥bin¥rtkget.exeを実行します。）

　　 1． Time Span（GPST）に GNSS観測を実施した日時をカバーするよう協定世界時
（UTC）で指定します 75。

　　 2． ファイルの保存先は、デフォルトでは C:¥GNSS_DATA¥product¥の中になるの
で、変更したい場合は LocalDirectoryにチェックを入れて「...」で「C:¥RTKLIB_

workspace¥input¥IGR」を選択します（図 H-5）。
　　 3． 「Options…」ボタンをクリックし、開いたパネルの「URL List File for GNSS Data」

から「URL_LIST.txt」の保存先を指定します（図 H-6）。
　　 4． リストから「IGR_EPH」を選択して、「Download」ボタンを押します。ファイルの

拡張子は、.sp3になります 76。
　　 5． リストから「IGR_CLK」を選択して、「Download」ボタンを押します。ファイルの

拡張子は、.clkになります 77。

74  GNSS観測データから得られる軌道情報（航法メッセージ）は、事前に計算されたパラメータを衛星から
送る予測暦のため精度は最良ではありません。精密暦は、後日地上で精密に計算したパラメータのため、
より高精度な値となっています。衛星の正確な軌道情報は、エフェメリス（Ephemeris）と呼びます。

75  時刻は GPST（GPS時間，協定世界時）となるので、日本時間から 9時間差し引いた日時になります。
76  IGR_EPHでダウンロードされるファイルは、GPS衛星軌道の決定暦です。ファイルは、GPS時間で

0～ 24時までで区切られているので、観測時間によっては複数のファイルがダウンロードされます。
Downloadボタンを押してもダウンロードできない場合は、FTPサイトにデータがまだアップされていな
い可能性があるため、数日後に再度試してください。

77  IGR_CLKでダウンロードされるファイルは、衛星クロックの補正情報が含まれます。

付録
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　　 6．「Files...」ボタンを押すと保存されたファイルを確認できます。

　　＊  rtkget.exeを使う方法の他にも、WEBブラウザで FTPサイト「ftp://cddis.gsfc.nasa.

gov/gnss/products/latest/」から直接ダウンロードすることもできます。
　　　 FTPサイト直下にある「final」フォルダには、12日遅れで利用できる決定暦が、「rapid」

フォルダには、17時間遅れで利用できる決定暦が、「ultra」フォルダには 1日 4回更
新される精密暦で 24時間分の予測暦が保存されています。データ公開までのタイムラ
グがそれぞれ違うので注意してください。

図 H-1　RTKLIBの Githuトップページの dataフォルダ

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 H-2　URL_LIST.txtをクリック

図 H-3　URL_LIST.txtの保存
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図 H-5　rtkget.exeで IGRS_EPHと IGRS_CLKをダウンロード

図 H-4　 C:¥RTKLIB_workspace¥inputフォルダの中に dataフォルダを作成して、その中に URL_
LIST.txtを入れる

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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図 H-6　Optionsパネル
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　付録 I.　国土地理院のWEBサイトの利用

①楕円体高から標高への変換方法
　国土地理院のジオイド高計算サイトで、楕円体高で出力された座標値を標高に変換する方法
を説明します。

（1） 国土地理院のジオイド高計算サイト（https://vldb.gsi.go.jp/sokuchi/surveycalc/geoid/

calcgh/calcframe.html）にアクセスします。
（2）入力単位選択を「十進法度単位」を選択します。
（3）緯度、経度に基線解析で得られた緯度経度情報を入力します。
　　＊  Microsoft Excelから値をコピーする場合は、セルをコピーして貼り付けると桁落ちす

るため、元の値を選択してからコピーをしてください。
（4）「計算実行」ボタンを押すとジオイド高が出力されます。
（5）楕円体高からジオイド高を引いた値が標高になります。

　例　 緯度、経度、楕円体高が「36.10377480555555、140.08785505555556、65.79m」の
場合

　　　標高 = 65.79m（楕円体高）– 40.1859m（ジオイド高）
　　　　　 = 25.6041m

図 I① -1　国土地理院　ジオイド高計算サイト

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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②緯度経度から平面直角座標への変換方法
　国土地理院の平面直角座標への換算サイトで、緯度、経度から平面直角座標系に変換する方
法を説明します。

（1） 国土地理院の平面直角座標への換算サイト（https://vldb.gsi.go.jp/sokuchi/surveycalc/

surveycalc/bl2xyf.html）にアクセスします。
（2） 測地系は「世界測地系」、平面直角座標系は、変換する地点の系番号を選択します。系番

号の場所はリンクから確認できます。
（3） 入力単位選択を「十進法度単位」を選択します。
（4）対空標識の緯度経度情報を入力します。
　　＊  Microsoft Excelから値をコピーする場合は、セルをコピーして貼り付けると桁落ちす

るため、元の値を選択してからコピーをしてください。
（5）「計算実行」ボタンを押すと平面直角座標系の座標値が出力されます。

図 I② -1　国土地理院の平面直角座標への換算サイト
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　付録 J.　大型プロッター用の簡易対空標識の原稿

　印刷して使用できる簡易対空標識を用意しました。任意のサイズに拡大、分割して、ご利用
ください。ポスター用プリンタ（大型プロッター）で不織布に印刷したり、耐久性の高い素材
（ターポリン等）への印刷を業者に注文したりしても良いでしょう。別添 PDFファイル（簡易
対空標識の原稿）を A0もしくは A0ノビサイズに拡大して印刷してください。

①地面に直接設置する用

②「GNSSアンテナ収納可能な対空標識固定専用マット（巻末付録 A⑤）」用

図 J①　対空標識（チェッカーフラグ）
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m
)
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図 J②　固定マット用対空標識

小型GNSS 受信機を用いた高精度測位マニュアル（ドローン用対空標識編）
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